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Before you begin

7is learner guide is based on the unit of competency BSBITU202 Create and use 
spreadsheets, Release 1. Your trainer or training organisation must give you information 
about this unit of competency as part of your training program. You can access the unit of 
competency and assessment requirements at: www.training.gov.au.

How to work through this learner guide
7is learner guide contains a number of features that will assist you in your learning. Your 
trainer will advise which parts of the learner guide you need to read, and which practice 
tasks and learning checkpoints you need to complete. 7e features of this learner guide are 
detailed in the following table.

Feature of the 

learner guide

How you can use each feature 

Learning content Read each topic in this learner guide. If you come across content that 

is confusing, make a note and discuss it with your trainer. Your trainer 

is in the best position to offer assistance. It is very important that you 

take on some of the responsibility for the learning you will undertake.

Examples and case 

studies

Examples of completed documents that may be used in a workplace 

are included in this learner guide. You can use these examples as 

models to help you complete practice tasks and learning checkpoints.

Case studies highlight learning points and provide realistic examples of 

workplace situations.

Practice tasks Practice tasks give you the opportunity to put your skills and knowledge 

into action. Your trainer will tell you which practice tasks to complete.

Video clips Where QR codes appear, learners can use smartphones 

and other devices to access video clips relating to the 

content. For information about how to download a QR 

reader app or accessing video on your device, please visit 

our website: www.aspirelr.com.au/help

Summary Key learning points are provided at the end of each topic.

Learning checkpoints There is a learning checkpoint at the end of each topic. Your trainer will 

tell you which learning checkpoints to complete. These checkpoints 

give you an opportunity to check your progress and apply the skills and 

knowledge you have learnt.
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Foundation skills
As you complete learning using this guide, you will be developing the foundation skills 
relevant for this unit. Foundation skills are the language, literacy and numeracy (LLN) 
skills and the employability skills required for participation in modern workplaces and 
contemporary life.

7e following table outlines speci,c foundation skills noted for your learning in this 
learner guide. 

Foundation skill area Foundation skill description

Reading  • Recognises numerical and textual information within a range 

of resources to determine and complete work according to 

requirements

Writing  • Enters and amends routine data into software using a format 

appropriate to requirements

Oral communication  • Listens to short and speci�c instructions and uses questions 

to clarify understanding

 • Uses simple mathematical language to con�rm and convey 

requirements

Numeracy  • Uses basic mathematical skills to create and apply 

spreadsheet formulae

Navigate the world of work  • Recognises, understands and adheres to legislative and 

organisational requirements in undertaking own work

Interact with others  • Recognises purpose of various communications directly 

relevant to own role and clari�es as required

Get the work done  • Uses key software features and functions in performing 

speci�c work tasks
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Before you begin

What do you already know?
Use the following table to identify what you may already know. 7is may assist you to work 
out what to focus on in your learning.

Topic Key outcome Rate your con�dence 

in each section

Topic 1 Select and prepare 

resources

1A  Adjust workspace, furniture 

and equipment to suit user 

requirements

 Con�dent

 Basic understanding

 Not con�dent

1B   Minimise wastage  Con�dent

 Basic understanding

 Not con�dent

1C   Identify and clarify spreadsheet 

task requirements
 Con�dent

 Basic understanding

 Not con�dent

Topic 2 Create simple 

spreadsheets

2A   Enter, check and amend data while 

maintaining consistency of design 

and layout

 Con�dent

 Basic understanding

 Not con�dent

2B   Use software functions to format 

spreadsheets
 Con�dent

 Basic understanding

 Not con�dent

2C   Use and test formulas to con�rm 

output meets task requirements
 Con�dent

 Basic understanding

 Not con�dent

2D  Overcome problems with 

spreadsheet design and production
 Con�dent

 Basic understanding

 Not con�dent

Topic 3 Produce simple 

charts

3A  Select a chart type and design 

to enable valid representation of 

numerical data

 Con�dent

 Basic understanding

 Not con�dent

3B  Create charts  Con�dent

 Basic understanding

 Not con�dent

3C  Use formatting features to modify 

the chart type and layout
 Con�dent

 Basic understanding

 Not con�dent
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Topic Key outcome Rate your con�dence 

in each section

Topic 4 Finalise 

spreadsheets

4A  Preview, adjust and print 

spreadsheets and accompanying 

charts

 Con�dent

 Basic understanding

 Not con�dent

4B  Ensure data input meets time lines 

and requirements for speed and 

accuracy

 Con�dent

 Basic understanding

 Not con�dent

4C  Name and store a spreadsheet, and 

exit an application safely
 Con�dent

 Basic understanding

 Not con�dent
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Select and prepare resources

Organisations use spreadsheets to store and calculate numerical data; for example, ,nancial 
statements and product pricing information. When you are required to enter data into a 
spreadsheet for your organisation, you must ,rst identify what kind of data it is and what 
would be a suitable way to enter it. For example, a report containing mainly text would be 
correctly entered using a word processing application, but data that has a lot of numbers 
probably needs to be entered into a spreadsheet. Once you have entered data, you will need 
to format it to suit your organisation’s style and presentation requirements. A spreadsheet is 
easier to read when it has been formatted.

In this topic you will learn how to:

1A Adjust workspace, furniture and equipment to suit user requirements

1B Minimise wastage

1C Identify and clarify spreadsheet task requirements
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Workplace safety is everyone’s responsibility. Employers and employees must make an active 
contribution to ensuring their workplace is safe. Hazards need to be identi,ed and risks 
assessed to reduce injury in the workplace. If you are working at a computer for an extended 
period each day, your workstation must be comfortable and designed for you to carry out 
your tasks eCciently. You will need to organise your work so that you are not doing a 
repetitive task for a long time. You should also take time to stand up and stretch. 

Another consideration in the workplace is to use resource conservation techniques to 
prevent wastage. Most organisations require staD to follow resource-saving procedures 
such as turning oD lights in unused rooms and 
recycling paper. You need to be aware of any 
conservation eDorts made by your organisation.

Workplace safety legislative 
requirements
All work health and safety (WHS) legislation 
requires employers to provide a safe workplace 
and adequate training and supervision, 
while controlling workplace hazards and risks. You must work in line with legislative 
requirements, regulations, Australian and industry standards, and the relevant codes of 
practice.

WHS legislation describes the legal requirements for ensuring workplaces are safe and 
healthy, such as:

• managing risks to health and safety

• promoting and maintaining the health, safety and welfare of people at work

• protecting people at work from injury and illness, including psychological injury

• protecting the health and safety of the public in workplaces

• consulting workers and encouraging participation in maintaining WHS

• providing rehabilitation and maximum recovery for injured workers.

WHS policy 
All workplaces in Australia are required to have a WHS policy that describes the 
organisation’s responsibility for the health and safety of its employees. 7e policy should 
include the organisation’s goals and objectives regarding WHS and a general set of 
guidelines related to health and safety in the workplace.

7e WHS policy will help you ful,l your duty of care as a worker for the organisation.

WHS procedures
WHS procedures are instructions developed to ensure all employees work safely and 
eDectively. In the context of working in an oCce and using a computer workstation, the 
following information should be contained in an organisation’s WHS procedures.

1A Use safe work practices1A Adjust workspace, furniture and 
equipment to suit user requirements
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Information contained in WHS procedures includes:

• workstation ergonomics

• standard safety precautions and housekeeping

• safe handling of hazardous substances (e.g. cleaning products)

• emergency and ,re drills

• hazard identi,cation and risk control

• manual handling

• emergency contact numbers, including local doctors and hospitals

• location of ,rst-aid equipment and ,rst-aid oCcers.

WHS regulations 
7e WHS legislation of each state or territory is supported by regulations and codes of 
practice. 7e WHS regulations support the legislation by outlining speci,c workplace health 
and safety requirements that must be addressed.

7e Model WHS regulations, which provide a framework that most states and territories 
have adopted, have speci,c requirements for hazardous manual tasks that must be 
addressed. 7ese requirements are summarised below.

Control measures

In determining the control measures to implement, the person conducting the 

business or undertaking must have regard to all relevant matters that may 

contribute to a musculoskeletal disorder, including:

 • postures, movements, forces and vibration relating to the hazardous manual 

task

 • the duration and frequency of the hazardous manual task

 • workplace environmental conditions that may affect the hazardous manual 

task or the worker performing it

 • the design of the work area

 • the layout of the workplace

 • the systems of work used

 • the nature, size, weight or number of persons, animals or things involved in 

carrying out the hazardous manual task.

Manage risk

A person conducting a business or undertaking must manage risks to health and 

safety relating to a musculoskeletal disorder associated with a hazardous manual 

task, in accordance with guidelines for managing risks to health and safety.

Code of practice: hazardous manual tasks
7e WHS regulations determine that it is a legal requirement for the person conducting a 
business or undertaking (PCBU) and workers to address hazardous manual tasks in the 
workplace. A PCBU has a broad de,nition that includes both employers and supervisors.
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7e code of practice for hazardous manual tasks was developed to provide guidance 
on how to manage risks associated with those manual tasks with the potential to cause 
musculoskeletal disorders (MSDs).

A PCBU must consult with workers, so far as it is reasonably practical, to develop their own 
set of procedures to manage the risk of MSDs.

7e hazardous manual tasks code of practice helps PCBUs and workers to:

• identify hazardous manual tasks

• assess the risks

• control the risks

• review the control measures.

Musculoskeletal disorders
MSDs come about in two main ways:

• Gradual wear and tear to joints, ligaments, muscles and inter-vertebral discs through 
repeated or continuous use of the same body parts, including static body positions

• Sudden damage caused by strenuous activity or unexpected movements, such as when 
loads being handled move or change position suddenly

7e repetitive movements and sustained body position associated with entering data into a 
computer is regarded as a hazardous manual task and puts the operator at risk of developing 
an MSD. 

MSDs may include conditions such as: 

• sprains and strains of muscles, ligaments and tendons

• back injuries, including damage to the muscles, tendons, ligaments, spinal discs, nerves, 
joints and bones

• joint and bone injuries or degeneration, including injuries to the shoulder, elbow, wrist, 
hip, knee, ankle, hands and feet

• nerve injuries or compression (e.g. carpal tunnel syndrome)

• muscular and vascular disorders as a result of hand-arm vibration

• so* tissue hernias

• chronic pain.

Standard precautions
Your workplace may need you to use standard precautions, 
particularly work practices related to the prevention of 
repetitive strain injuries (RSIs). 7ese include ergonomic 
practices, workstation design, enforced breaks and exercise 
routines.

Workers in an oCce environment follow standard precautions 
when using a computer workstation. However, research on 
sitting has demonstrated that other precautions also need to 
be considered, such as the use of standing workstations, to 
ensure that injuries are prevented. It is important that you 
carefully follow any standard precautions that are prescribed 
for your workplace.
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Equipment and systems safety checks
An important part of your daily work routine is to check the various systems and equipment 
you will use during the day to make sure they are in correct working order. Your workplace 
policies and procedures should include the steps to follow. You may need to perform this 
procedure at the start of your working day or at speci,ed intervals during the day.

Workstation safety procedure/checklist:

• Seat is positioned in front of your computer and you can reach your keyboard 
comfortably.

• Computer monitor is positioned out of direct sunlight and at the correct height. 

• Environment is dust-free as dust can aDect the monitor or central processing unit of a 
computer.

• Cables are secured so no-one trips over them.

• Blinds and window coverings are used to reduce glare and heat at your workstation.

• Temperatures don’t exceed 26 °C and humidity is between 40 and 60 per cent.

Use ergonomic practices in the workplace
7e aim of ergonomics is to reduce the risk of accidents, injury and ill health by applying 
safe work practices. Ergonomics is about creating comfortable working conditions by 
adapting workstations, tools and equipment to an individual worker’s needs. It also 
improves performance and productivity in the workplace. Ergonomics covers all aspects 
of working, from physical stresses such as sitting at a workstation all day to environmental 
factors such as noise, air-conditioning and lighting.

Set up your workstation
A workstation includes a computer, screen, keyboard, mouse, desk and chair. How your 
workstation is designed can aDect your health and wellbeing. Several physical problems can 
result from poor workstation design; for example, lower back strain may result from sitting  
in a chair that does not support your back. Below are some guidelines for setting up your 
workstation to be ergonomically eCcient.

Chair

Adjust your chair height so that your feet are  at on the  oor, your thighs are 

horizontal and your lower legs are vertical to the  oor.

Adjust the backrest by raising it to the maximum height and then lower it until 

it �ts the curve of your lower back. If this is not comfortable, lower it another 

couple of centimetres. Continue this until a comfortable position is found. The 

backrest should support your lower back.

The backrest may also be adjusted backwards and forwards. When seated in 

your usual working position, move the backrest until it exerts a gentle pressure 

on your lower back. Make sure there is at least two centimetres of space 

between the front of the seat and the back of your knees. Armrests should be 

positioned so that they do not interfere with carrying out your tasks.
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Screen

Once you have adjusted your chair and desk, you can position your screen. 

Adjust it so that the top of the screen is level with or slightly lower than your 

eyes. If you can’t adjust the screen to the correct height, place the screen on a 

platform.

The screen should be at least 50 centimetres or an arm’s length away from your 

seated position to minimise radiation exposure; however, you should always 

adjust the position of the screen to suit you. It is best to position the screen so 

that you can clearly read the text without leaning forward, twisting your neck, or 

looking too far upwards. Also take surrounding factors into consideration, such 

as re ection, glare and shadow, when positioning your screen.

Mouse

Place the mouse and mouse mat directly beside your keyboard on the side you 

prefer. If you use the mouse frequently, you could try to alternate sides. You 

will be surprised at how easy this becomes with practice. Your wrist should be 

straight, and the desk should support the weight of your wrist, not your arm. Try 

to keep your wrist  at and rest your �ngers on the mouse between clicks. Hold 

the mouse lightly. Don’t hold onto the mouse when you are not using it.

Keyboard

The angle of your keyboard can be adjusted to suit your comfort level by moving 

the supports underneath it. Place the keyboard as close as possible to the 

front of your desk. Don’t place documents between yourself and the keyboard, 

as stretching will eventually cause muscle strain in your arms, shoulders and 

neck. While typing it is best not to rest your wrists, as they should not be bent 

up, down, or to the side. The knuckle, wrist and top of the forearm should form 

a straight line. Wrist supports or rests give you a place to rest your hands only 

when pausing from typing, not while you are typing. Do not pound the keys; use 

a light touch. Leave enough room on your desk to put the keyboard out of the 

way when you are not using it.

Desk

When you sit at your desk, the surface should be just below your elbow height. 

If your desk is not height-adjustable, try to raise your chair so you are sitting at 

the correct height, and use a footrest to make up the difference. If your desk 

is too low, you may be able to extend the legs. You should have plenty of leg 

space underneath your desk. Don’t clutter the space with bags and bins, as your 

legs may become cramped and your posture twisted. Position any equipment 

or materials you use so that you can reach them easily without twisting. For 

example, stationery items you frequently use should go in the top desk drawer, 

and your keyboard and screen should sit directly in front of you to avoid having 

to angle or twist your body.
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Workstation features
7e features of an ergonomic workstation are highlighted in the diagram below. Some 
features of the workstation may vary depending on the type of computer work being 
performed. Graphic work may require the use of a pen tool, and multiple monitors are 
commonly used for a variety of digital work.

Top of screen The screen angle should be adjustable between 85 and 125 

degrees to the horizontal. 

Centre of screen Minimise screen re ection and glare by using an anti-glare �lter.

Bottom of screen Place a document holder beneath or beside the screen at the 

same viewing distance as the screen.

Top line of sight The viewing distance should be between 400 mm and 700 mm.

Bottom line of sight A relaxed viewing angle is approximately 35 degrees.

Head Keep your head erect.

Shoulder Have your upper arms hanging freely.

Elbow Have your forearms approximately horizontal.

Above knee Ensure there is clearance between the lower edge of the desk and 

your legs.

Below knee Ensure there is clearance between the front edge of the seat and 

the lower leg.

Footrest Use a footrest if needed.

Back of chair The back support should be adjusted to support the small of your 

back.

Under chair Adjust the seat height to suit your furniture and equipment.

Chair legs Use a chair with a �ve castor base.
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Desktop layout

Items on your desk, including equipment and resources, should be arranged within 
easy reach.

Your desk area can be divided into three zones:

• the optimum reach zone – the area closest to you, where your hands operate most of 
the time

• the maximum reach zone – further away, but still close enough to reach comfortably

• the outer reach zone – where you may have to bend forward or stand to reach items.

Make sure your desk is organised so that frequently used objects, such as your keyboard, 
are close to you. Intermittently used objects, such as your phone, should be out of the way 
but still within easy reach. Other resources used less frequently, such as in- and out-trays, 
should be in the outer reach zone.

Adjust your equipment and posture
When your posture is poor, you may suDer from aches and pains. Spending a long time in 
the same position can put stress on your body and this can be made worse if you are in an 
uncomfortable or poorly supported position. 7ese symptoms may start out very slight, but 
if you continue to use poor posture they may get worse and become intolerable. 7ey may 
result in cumulative stress given the constant stress on your muscles, nerves or tendons. 
When setting up your workstation, you need to make sure your posture will not cause you 
pain or discomfort. 7e equipment you use needs to be adjusted to suit your body shape and 
size, and the tasks you are doing.

You have already looked at adjusting your screen and chair. 7ere are other oCce tools that 
can help your posture. 7ese include the following items.

Footrests

A footrest may be necessary if you can’t 

place your feet comfortably on the  oor. 

Footrests allow your feet to rest at the 

correct height and on a tilting angle, which 

prevents strain on the lower back. 

Headsets

If you use a telephone for long periods of 

time, it is a good idea to use a headset. A 

headset will keep your neck straight and 

your arms free. Headsets prevent you from 

bending your neck to support the telephone 

handpiece.
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Document holders

Document holders are designed to hold 

papers and reference material in a 

convenient position for viewing. Place your 

document holder in the correct position. 

If it is below the screen or too far off to 

the side, each time your eyes look from 

one source to the other, your pupils have 

to adjust. Doing this for long periods of 

time can cause headaches and eyestrain. 

Place the document holder at a similar 

level, angle and distance as the screen to 

avoid having to shift eye focus.

Angle boards

Angle boards allow the user to maintain 

correct posture when reading, by reducing 

the angle between the work surface and the 

vertical posture. Adjustable to a suitable 

height and angle, these supports enable 

comfortable reading with the neck correctly 

positioned. Try to keep your neck as straight 

as possible when you are reading.

Home o4ce
Communication technology and organisational policies to maintain a sustainable work–life 
balance are creating opportunities for more Lexible working arrangements. 7is means that 
more employees are working from home oCces or in other remote oCce locations. Many 
bene,ts can be derived from Lexible working arrangement for employers and employees, 
but there is still a responsibility for all parties to make sure that home and remote oCces use 
ergonomic practices and follow WHS requirements.

Hot desking
Hot desking is an oCce organisation system that is used in some workplaces where 
workstations are not assigned to an individual worker. Workstations may be used by 
multiple workers during diDerent time periods or shi*s. 

7e motivation behind hot desking is primarily the cost savings achieved by setting up 
fewer workstations in workplaces where not all the workers are in the oCce at the same 
time, or not in the oCce for long periods at a time. 

Another common adaptation of hot desking is where work stations are assigned to 
individual workers, but need to be readily available for other workers to access based on 
daily work requirements, such as a group of people coming together to work on a speci,c 
project.

WHS and workplace culture considerations with hot desking

 • It is common for workers to want their own space. Consequently, they may 

tend to choose one location and stick to it.

 • It can take extra time each day to set up a work station for ergonomic and 

work ef�ciency. 

 • Personal hygiene needs to be maintained to prevent the spread of germs on 

keyboards and desk surfaces.

 • Workstations need to be tidied appropriately in readiness for the next user. 

This can also involve some cleaning.
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Standing desks
Sitting at a desk for long periods of time has many 
negative health impacts. It is claimed that the negative 
eDects of prolonged sitting cannot be counteracted by 
regular exercise and that the only way to eliminate this 
problem is to avoid sitting as much as possible. 

7ese negative health impacts can be overcome through 
the use of standing desks. Standing provides a greater 
opportunity for your body to move and adjust and 
involves more muscular activity than sitting.

Some of the health bene,ts from standing include:

• alleviating back pain and other repetitive stress 
injuries by greater use of core back muscles to support 
the upper body

• increasing focus, alertness and activity level by releasing restless energy

• reducing the risk of developing cardiovascular disease, diabetes and blood clots, which 
can be caused by prolonged sitting.

Standing desk ergonomics
Using a standing desk for hours on end requires you to adapt. It is recommended that you 
start using a standing desk gradually by alternating between sitting and standing. You may 
experience sore feet, tired legs and fatigue at ,rst. Wear comfortable shoes and use an anti-
fatigue Loor mat.

An ergonomically designed standing work desk means you can maintain correct posture 
while working. 

Position arms at 90 degrees when typing/standing.

Place the computer screen at eye-level and tilting it slightly upwards.

Place the computer monitor at least an arm’s length away.

Avoid leaning over the desk; keep your body straight. 

Monitor environmental factors
Environmental issues in the workplace include lighting, noise control and air quality. If 
the environment of your workplace is not monitored and controlled, you may suDer from 
headaches, fatigue, hearing loss or eyestrain.
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Light

Good lighting is essential for a safe and hazard-free workplace. You need to see things 
clearly to work eDectively. Simply shi*ing the screen slightly, adjusting blinds, altering the 
brightness settings on the screen and using desk lamps can avoid many light hazards. Try 
to use natural sunlight if the oCce layout can accommodate this. If not, keep bulbs and 
,xtures clean, focus light on your task and use Luorescent lights if possible.

Improper lighting can cause eyestrain and headaches.

Hazards associated with lighting include:

• glare – a computer screen positioned in front of a bright window can be diCcult to see

• Lickering lights – a Luorescent light may malfunction, causing annoyance, irritation 
and nausea

• inadequate or dim light – reading in dim light causes eyestrain

• reLections – sunlight reLecting on a screen can make it diCcult to read

• shadows – shadows shi*ing across your work area can cause you to sit with bad posture 
in order to read your work.

Noise

Noise can include any annoying or disturbing sound. Excessive noise around heavy 
machinery or equipment can cause permanent hearing loss. Noise is a problem if it disturbs 
people, distracts them, interferes with communication, causes people stress or generally 
interferes with their work.

Many oCces are open-plan in design, o*en with employees seated close to each other and 
divided by partitions at chest or head height. 7ink about noise levels when you set up your 
workstation. It should be possible for people in open-plan oCces to have some privacy when 
they are on the telephone and carrying out their day-to-day activities.

Noise in the oCce can come from:

• machines (photocopiers, fax machines, printers)

• other equipment (telephones, paging systems, music)

• background noise (li*s, air-conditioning, traCc)

• people talking.

Noise management

Noise can also be a problem outside oCce environments, such 
as on factory Loors, at construction sites or near airports. You 
may have to wear ear protection if you are required to work in 
excessively noisy areas.

7ere are many ways that problem noise can be controlled 
in the workplace. Noisy machines can be put in a separate 
room or area. Sound-absorbent materials such as carpet and 
partitions can be installed or arranged to deLect and absorb 
noise. 7e volume level on your telephone’s speaker can be 
adjusted.

Remember that noise is only a hazard when it is stopping you from working productively, 
comfortably and safely. Many people prefer to work with low levels of noise rather than 
complete silence.
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Air

Air-conditioned oCces do not have fresh air from open windows. 7is can cause problems 
for some people.

OCce workers frequently complain of being too hot or too cold. If a person’s desk is near an 
air-conditioning outlet, the area around their desk can be much colder than elsewhere in 
the oCce. 7ey can also suDer from dry and itchy eyes. Report such hazards to the relevant 
person. 7is situation can usually be corrected by adjusting air-conditioning Low.

Organise your work
Having a well-planned workstation and comfortable surroundings is pointless if you don’t 
organise your work in a way that prevents discomfort or pain. Make sure you plan your 
daily tasks so that you aren’t doing repetitive work for long periods of time. Make sure you 
take rest breaks and exercise regularly.

Positive work organisation includes:

• a mixture of repetitive and other activities

• rest periods

• exercise breaks.

Vary your activities

Your work role may involve several diDerent tasks. Some tasks may be repetitive, such as 
typing up reports or entering data. If you are able to vary the tasks you carry out each 
day, this will help prevent repetitive actions that cause stress to your body. For example, 
if you have to enter a lot of data, break up the repetitive nature of the task by discussing a 
project with a fellow worker, collecting some research from the internet or doing another 
constructive workplace task you are responsible for. WorkLow should be designed to reduce 
the repetitive tasks given to particular people.

Take rest periods

All employers need to provide rest periods for employees. Rest periods include tea breaks 
and lunch breaks. During the working day everyone needs to sit down, breathe easily, relax 
and take time to think about something other than work.

Have exercise breaks

When working with a computer, you should have short breaks at regular intervals to combat 
stress and prevent pain and discomfort. As discussed previously, using computers for too 
long without breaks has been associated with back and neck pain, headaches, migraines and 
eyestrain.

Try the following exercises several times a day, and encourage others 
around you to try them. Make sure you are relaxed and stretch gently, 
without overstretching. Stop if you feel any pain or discomfort, and 
remember to exercise both sides of your body. Most importantly, breathe 
deeply and evenly throughout the stretch.

v1
3

2
3
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Eyes Every 20 minutes, look away from the screen. Focus on a distant 

object (more than three metres away).

Shoulders and arms Stretch your arms above your head, cradle your elbow with your 

hand and gently pull your elbow behind your head. Repeat on the 

other side, holding the stretch for 10 seconds.

Upper and lower back In a standing position place hands in the small of the back. 

Gently arch back and hold for 10 seconds. Repeat when needed.

Wrists, hands and arms Interlacing �ngers, turn palms upwards. Now lift arms over your 

head and stretch, leaning gently to the left and then to the right. 

Repeat movement several times.

Shoulders Sitting with a straight back and neck, roll your shoulders forward, 

then back. Repeat several times.

Neck Turn your head gently to look over your right shoulder. Hold for 

10 seconds. Now roll your head forward to look over your left 

shoulder and hold for 10 seconds. Repeat several times.

Work without stress
Here are some tips for working without stress.

Tips to help minimise stress

 • Adjust your chair and desk to suit your body.

 • Position your screen to suit your posture.

 • Adjust other equipment for safe and comfortable use.

 • Reduce excess noise.

 • Ensure you have adequate light.

 • Arrange your desktop so you can access things easily.

 • Take regular breaks from your work.

 • Frequently rest your eyes.

 • Do stretching exercises.

 • Vary your tasks.
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Practice task 1

Here is a checklist to follow when setting up your workstation. Go through the points that are relevant 

to you and make any necessary adjustments to your work or study space. You may need another 

person to help you and check your posture. If you are not able to tick some of the checkpoints, 

change your study space or discuss making alterations to your workstation with your manager.

Chair

q Is the seat height-adjustable?

q Is it high enough to allow you to sit comfortably over the keyboard?

q Is it stable?

q Does it swivel?

q Is the height of the backrest adjustable and does it tilt backwards and forwards?

q If it has arms, can you still get close enough to the desk and swivel the chair?

q Are your feet  at on the  oor, or are you using a footrest?

q Are you sitting up straight with the backrest �rm against your back?

Desk

q Is it large enough to allow the screen and keyboard to be correctly positioned?

q Is it low enough to allow you to keep your forearms horizontal or sloping downwards?

q Is it high enough to allow your thighs to �t underneath it?

Keyboard

q Can it be tilted to allow you to adjust it?

q Are the symbols on the keys clear and easy to see?

q Is there suf�cient space in front of it to allow you to correctly position your arms?

Screen

q Does the screen have easily adjustable brightness and contrast controls?

q Is the image on the screen stable and  icker-free?

q Are there adjustment mechanisms to allow the screen to be tilted, swivelled or raised to avoid 

glare and re ections and help you keep a natural and relaxed posture?

q Are you sitting far away enough from it for comfort?

continued …
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… continued

1. Describe the possible consequences for an organisation in which employees do not consider 

their physical health.

2. What should a WHS policy include?

3. What should WHS procedures include?

4. Why should you vary the tasks you carry out each day?
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Conserving resources at work bene,ts not only the organisation by reducing costs, but also 
the planet by reducing greenhouse gases and the amount of waste sent to land,ll. Most 
organisations have policies and procedures for conserving 
resources. You can ,nd out what these are by reading your 
workplace manual or asking your manager or colleagues.

Ways to conserve resources at work include:

• minimising paper wastage

• reducing energy use.

Minimise paper wastage

Wasting paper costs organisations and the planet a great deal. 
Consequently, many organisations have developed policies for paper usage. 7ese include:

• using both sides of the paper when photocopying

• recycling non-con,dential waste paper in recycling bins

• storing email messages in an electronic folder instead of printing

• reducing the volume of printing where possible

• reusing paper by using blank sides for rough dra*s and reusing folders and ,les

• using recycled paper or paper from plantation timber for printed documents

• using a recycling service to collect waste paper.

Example: o4ce paper

Using the following statistics, consider how many trees are used for of�ce paper.

How many trees are used to produce paper?

 • One ton of uncoated virgin (non-recycled) printing and of�ce paper uses 24 trees.

 • One ton of 100 per cent virgin (non-recycled) newsprint uses 12 trees.

 • One ream (500 sheets) of paper uses six per cent of a tree.

 • One tree makes 16.67 reams of copy paper, or 8,335 sheets.

 • One carton (10 reams) of 100 per cent virgin copier paper uses 60 per cent of a tree.

 • One ton of coated, non-recycled higher-end magazine paper (used for high quality 

photographic magazines) uses more than 15 trees.

 • One ton of coated, non-recycled lower-end magazine paper (used for news magazines and 

most catalogues) uses nearly eight trees.

The statistics in this example are based on US short tons (2,000 pounds), not metric tonnes.

Source: www.conservatree.com

1B Minimise wastage
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Minimise energy use

Wasting energy also costs organisations and the planet a great deal. Many organisations 
have developed policies and procedures to save energy. 7ese include:

• providing training programs on smart energy practices so that employees can practise 
energy eCciency

• turning oD equipment when not in use

• using power-save functions for equipment

• re,lling toner and ink cartridges from printers.

Resource conservation
Here are some tips for practising conservation.

Resource conservation tips

 • Use the power-save function on printers when they are not in use.

 • Print and copy on both sides of the page, where possible.

 • Use recycled paper (paper used on one side) in the photocopier and 

printer for rough drafts.

 • Use recycled paper for telephone messages.

 • Place a recycling bin near the photocopier.

Practice task 2

1. List three policies developed to minimise paper wastage at your organisation, or one you are 

familiar with.

2. List three policies or procedures developed to minimise energy use at your organisation, or one 

you are familiar with.
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Organisations use spreadsheets to store and perform  
calculations on numerical data. For example, sales 
,gures and payroll information are usually stored on 
spreadsheets. Once the data has been entered, 
calculations can be performed on the numbers to 
produce a required result, such as total monthly 
takings or a calculation on interest payments.

Many organisations have speci,c requirements 
in relation to how data is stored and the way it is 
displayed and presented. You must be aware of 
these requirements so your spreadsheet meets your 
organisation’s standards. 7ese requirements may 
be in relation to how the data is entered, stored, 
presented, output or produced.

Requirements for the task may also be speci,ed by your supervisor or the person requesting 
the information. It is important to follow instructions and clarify requirements. Part of 
clarifying requirements is asking questions; it may also include checking information and 
the presentation of past spreadsheets, as well as showing someone a dra* of the spreadsheet 
prior to completion. Organisational and task requirement instructions form another type of 
check for when you complete the task. 

Spreadsheet software
In accounting, a spreadsheet is a large sheet of paper that displays a company’s ,nancial 
position. It spreads or shows all ,nancial information (such as costs, income and 
taxes) on a single sheet of paper for a manager to look at when making a decision. An 
electronic spreadsheet organises information into columns and rows. 7e data can then 
be manipulated by a formula to provide a total (sum). 7e spreadsheet can present the 
information in a format to help a decision-maker see the ,nancial ‘big picture’ of an 
organisation. 

All organisations need to manage and store numerical data and a spreadsheet is the 
most appropriate tool for doing this. 7e most commonly used spreadsheet so*ware is 
Microso* Excel.

Before you begin
Before you start entering data into a spreadsheet, you should be familiar with the screen 
elements of a spreadsheet. Spreadsheets are made up of worksheets and workbooks. A 
worksheet is divided into columns and rows and the intersection of a column and row is 
called a cell. 7e current cell is shown by a highlighted rectangle that is called the ‘active 
cell’. A workbook is a collection of worksheets.

7e following example is Sheet 1 in Book 1. A1 is the active cell.

1C Identify and clarify spreadsheet 
task requirements
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Worksheet

If you look closely at this spreadsheet, you will notice there are a number of screen elements. 
7e following sections explain each of the screen elements.

Title bar

7e title bar holds the name of the workbook. It has the standard minimise, restore and 
close functions found in all Microso* OCce products.

Ribbon – tool buttons

In Microso* Excel 2013, toolbars have changed signi,cantly from earlier versions of the 
program. 7e program now operates by using a number of tabs available from the ribbon. 
7ese provide you with easy access to a wide variety of commonly used tools.

7e ribbon has various tabs. You can easily switch between each tab to access tool buttons 
that you might need to use. 

7ere are also other tools that are relevant to an action you are performing. For example, 
when you choose to insert a chart, additional sets of tools appear under Design, Layout and 
Format tabs.

Each tab has groups of tools available. For example, under the Home tab, the groups are 
clipboard, font, alignment, number, styles, cells and editing.
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You will need to familiarise yourself with the various tools that are available in Excel 2013. 
However, the most common tabs you will use are Home, Insert, Page Layout and View.

To learn about the various tool buttons, rest your mouse pointer on the button. A help 
bubble that brieLy describes the purpose of the tool button will appear.

Formula bar

A worksheet is made up of cells. 7e Formula Bar displays the current cell reference and is 
used to view and edit a cell’s contents. When entering data in a cell, you will see cross and 
tick buttons  appear on the Formula Bar. 7ese are the Cancel and Enter ticks. 
Accept your entry by clicking on the tick (or simply press the Enter key on the keyboard), or 
cancel it by clicking on the cross.

Active sheet

As per default workbook settings, each new workbook contains three blank worksheets. 
It is possible to add or delete worksheets, and rename worksheets if you need to. An 
example would be to have a workbook that contains yearly sales data where each worksheet 
contains speci,c data (such as sales data for each quarter) and each worksheet is named 
appropriately; for example, quarter 1, quarter 2, quarter 3, quarter 4. It is possible to view, 
and work with, data contained in each worksheet by simply clicking on the sheet name.

You can rename a worksheet by right clicking on the existing name (for example, Sheet1) 
and selecting Rename. Type in the new name and press Enter.

Enter data into a worksheet
Numbers and text can be typed into a cell. Text entries are called ‘labels’ and numeric 
entries are called ‘values’. To enter data into a cell, you must ,rst select it to make it active. 

Enter data

7e following steps show how to enter data to create a spreadsheet:

• Open Excel.

• Click inside C2 and enter Current Clothing Label.

• Enter Month, Income, Expenses, Pro!t and Clear Pro!t in the fourth row. Look at the 
following example to help you.

• Enter January in A5 and select the cell. Use Fill to add the months in column A. 7e 
Fill handle is a small black square at the bottom right of the cell . 

Position your cursor over the Fill handle until a cross appears. While pressing the le* 
mouse button, drag the Fill handle down through the required cells until you reach 
December, then release the button. Excel will automatically ,ll in the months for you.

• Enter values under Income and Expenses. You will be using the values you enter in 
calculations later, so try to be accurate.

• Save your worksheet in a suitable location on your hard drive and name it ‘Current 
Clothing’.
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Alter data

Once you have entered data, you may have to 
alter it to correct errors or update it for changing 
organisational requirements. You can alter the 
information in a cell by selecting the cell and directly 
entering the new information, or by using the 
Formula Bar:

• Click in the E4 cell Clear Pro,t. 7is cell is now 
current.

• 7is cell’s content will be displayed on the 
Formula Bar.

• Click on the Formula Bar to select it, or press the 
F2 key on the keyboard. Change the word ‘Clear’ 
to ‘End’.

• Press Enter or click the Enter tick  on the Formula Bar to con,rm 
the change.

• Select one of the numbers you have entered in the Income column. Press the Delete key 
to delete the information. Retype a new number.

• Save your changes and close your worksheet.

Select cells
Once you have entered data into a worksheet, you will need to select data in order to format 
it or perform calculations. You may need to select some or all of the data on a worksheet. 
When data is selected, it is highlighted on the screen. 7e following information describes a 
number of techniques for selecting cells.
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Select a group of cells by dragging the mouse

 └ Click on the �rst cell in the range that you want to select. Hold down the 

left mouse button and drag over the required cells. Alternatively, click on 

a cell to select that single cell.

Select a row

 └ Click on the row number button; for example  .

Select a column

 └ Click on the column letter button; for example  .

Select the entire worksheet

 └ Click on the button  to the left of column A, or on the keyboard 

press Ctrl and A.

Select multiple ranges

 └ Select cells using any of the above methods and then hold down the Ctrl 

key before selecting the second range of cells.

Storage, output and presentation
Once you have entered data into your worksheet, you 
need to know what the required output is, how it should 
be presented and where it should be stored. For example, 
your manager may need you to enter monthly sales ,gures, 
for which a total calculation must be made. In this case 
you need to add a column with a label of ‘Total’. You may 
need to format your spreadsheet to match organisational 
requirements; for example, you may need to use a certain 
font type and size for labels, and precise information in the 
header and footer.

Where you store your spreadsheet depends on who needs 
the information. When you create a spreadsheet, you need to save it immediately. You can 
save it to your personal hard drive or to a shared drive on your organisation’s server. A 
server is a computer that delivers information to other computers linked by a network. Ask 
your manager where you should save your spreadsheet to ensure that you are adhering to 
company protocols. 
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Practice task 3

1. Describe the main purpose of a spreadsheet.

2. Describe the following components of a spreadsheet:

 • Workbook

 • Worksheet

 • Cell

3. How do you make a worksheet current?

4. What function key will access the Formula Bar?

5. Describe how you can use the Formula Bar to alter data in a cell.
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Summary

1. Ergonomics is about creating comfortable working conditions. Setting up a workstation 
to suit your physical requirements prevents undue stress and strain.

2. Environmental factors in the workplace, such as lighting, noise and air quality, aDect the 
health of employees.

3. Plan daily tasks and rest periods to prevent repetitive work being done for long periods 
of time.

4. Performing exercises during the working day can prevent pain and discomfort.

5. Conserving resources at work bene,ts the organisation by reducing costs, and bene,ts 
the planet by reducing greenhouse gases and the size of land,lls.

6. Spreadsheets are made up of worksheets and workbooks. A worksheet is divided into 
columns and rows, and the intersection of a column and row is called a cell.

7. You can change the appearance of your spreadsheet to suit your organisation’s style and 
presentation requirements.
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7is learning checkpoint allows you to review your skills and knowledge in selecting and 
preparing resources.

Part A
1. List some reasons that a person may suDer physical discomfort when spending a lot of 

time at a workstation.

2. For each reason you have listed, describe a solution that could relieve the physical 
discomfort.

Learning checkpoint 1 
Select and prepare resources
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3. Describe four types of oCce equipment you could use to help your posture in the 
workplace. Explain the bene,ts of each piece of equipment. 

Part B
7ink about this statement: 7e environmental factors of a building can contribute to the 
productivity of an organisation. 

Write half a page describing how noise, light and air quality could aDect productivity 
at work.
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Part C
Using the table below, list as many conservation techniques as you can think of in relation to 
two ways of conserving resources in an oCce environment: minimising paper wastage and 
minimising energy use.

Minimising paper wastage Minimising energy use

Part D
Read the case study, then complete the tasks that follow.

Case study

Angelina works as an administration of�cer. Her main tasks are reception duties, word 

processing, handling the mail and �ling. Most days Angelina’s manager gives her urgent work in 

the afternoon that needs to be completed that day. Her time lines are always very tight and she 

often �nds that she has to work during her lunch hour and for an extra half-hour in the evening. 

She is always exhausted and is becoming stressed.

To make matters worse, Angelina �nds that work is often just dropped on her desk, which 

makes her desk disorganised and dif�cult to use. She can’t alter her chair and there is glare 

coming from her monitor. She often leaves work with a headache and a backache.
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1. List all the unsafe work practices Angelina is experiencing.

2. For each of the unsafe practices you have listed, describe a solution.
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3. On half an A4 page, describe why work organisation and ergonomics lead to better 
employee health.

Part E
Which of the following data types would suit being entered and stored in a spreadsheet?

• Budget information

• Payroll data

• A report about WHS

• Taxation information

• Superannuation contributions

• A letter to a client

• Sales targets

• Bank reconciliation information
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Part F
Create the following spreadsheet, which provides a summary of sales results for sales 
consultants at Henry Lewis Consulting & Co.

1. Use Fill to create the list of months.

2. Alter the December ,gures as follows:

• Hannah – 5909

• Joe – 2343

• Fredrick – 1231

• Simon – 2324

• Carolyn – 4358

• Nim – 13210

3. Save the document and name it ‘Henry Lewis – sales results’.
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Producing a spreadsheet means creating it and having it ready for your colleagues or 
supervisor to read. When producing spreadsheets, you need to check the data you 
have entered for errors and make sure the content and format suit your organisation’s 
requirements. For example, you may need to proofread the data manually or use the 
spellchecker installed in the so*ware you use.

If you have been asked to produce a spreadsheet, be aware of when the spreadsheet is 
needed, so you can have it completed on time.

If you experience diCculties when producing a spreadsheet, you need to know where to go 
for help; for example, you could use a paper-based manual or go online. You should know 
which websites have up-to-date information about the so*ware you are using.

In this topic you will learn how to:

2A Enter, check and amend data while maintaining consistency of design and layout

2B Use so*ware functions to format spreadsheets

2C Use and test formulas to con,rm output meets task requirements

2D Overcome problems with spreadsheet design and production
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Data entered into Microso* Excel worksheets consists  
of text, numbers or dates/times. Examples of text 
entries include names, addresses and product 
information. Examples of numbers include 
quantities, customer numbers, pricing and sales 
,gures. Examples of dates/times include dates of sale, 
dates of entry and monthly date ranges. When data is 
entered, Excel treats the data diDerently depending 
on whether it is text, numbers or dates/times.

Data must be entered, checked and adjusted as 
per organisational and/or task requirements. For 
example, your organisation may prefer that dates 
be formatted as follows: 27 Aug 16. So if a date 
was formatted as 27/08/2016, it would need to be 
amended.

Data entry
To enter data into Excel, the cell in the worksheet must be activated. Entering data into a 
blank cell only requires you to select the cell, type the data and press Enter on the keyboard. 
7e data will now be contained in the cell.

7e automatic default for data entry in Excel is that each time you press Enter on the 
keyboard, the activated cell will move down through the worksheet.

To adjust the way this works (for example, to make the next selected cell the one to the 
right), select the File tab and click Options. Select Advanced and alter the Editing options 
as follows:

Edit data
To edit data (which means to change it), it is necessary to activate the cell contents. A 
common processing problem occurs when people want to change the data; for example, 
from Simon Jones to Simone Jones. Instead of editing the data only (that is, adding an ‘e’ to 
Simon), people select the cell and retype all of the information. 

7e correct procedure is to activate the cell and adjust the entry as appropriate. 

Any of the following actions will activate a cell:

• Double-click into the selected cell.

• Press F2 on the keyboard.

• Click into the formula bar of the selected cell and amend the entry.

2A Enter, check and amend data while 
maintaining consistency of design and layout
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Text entry

Each cell in an Excel worksheet can contain approximately 32,000 characters. In most cases, 
this is more than adequate for the data that each cell needs to contain. 

When entering text, you will notice that a*er you have entered the data, it is automatically 
aligned to the le* of the cell. You will also notice that if there is no data in the adjacent cell, 
the text will overLow across adjacent cells.

If, however, there is data in the adjacent cell, the text that is entered appears to truncate. 

Many people are confused by this and think that the data is lost. However, it is still 
contained in the cell. If you select the cell again, you will notice that the formula bar (at the 
top of the sheet) shows the full content of the cell. 

To ensure the printed and on-screen versions of the document both show the full content 
of the cell in the worksheet, you need to adjust the width of the cell and/or ‘wrap’ the text 
within the cell parameters. 

Number entry

When entering numbers, the automatic alignment will be to the 
right of the cell. In most cases, if the number is longer than the cell, 
the width of the cell will automatically adjust. 7e number of 
characters for a value is limited to 15.

Sometimes numbers do not appear as you expect, as in the 
following example. 7is occurs when the number is too long 
for the cell width. 

Adjust the width of the cell to correct this problem.

Date and time entry

Date and time entries also align to the right of the cell. When you enter 
the data, date and time formatting is applied to the cell. In Microso* 
Excel 2013, it tries to match the formatting with the way the information 
is typed in.
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Adjust cell width

7e easiest way to adjust the width of a cell is to position 
your cursor between the column headings at the top of the 
worksheet and drag the cursor right or le* to where you want 
the width of the cell to be.

Alternatively, you can AutoFit the cell width to the longest entry by double-clicking 
between the column headings. 7e columns will automatically adjust.

To wrap text in a cell, select the cell(s) and use the Wrap Text tool , which is 
located on the Home tab.

Sort data alphabetically
O*en, data needs to be sorted; for example, sorting customer 
family names alphabetically, sorting in date order and sorting 
by customer reference number.

To sort the data alphabetically, select the Sort & Filter tool from 
the Home tab and then select Sort A to Z. 

You do not need to select the data; just make sure the cursor 
is located in the column you want to sort. Excel recognises 
adjoined columns and rows and sorts them appropriately. Excel 
also recognises label headings and does not include these in the 
sorting. 

If, however, there are blank rows or columns, Excel will not 
include these in the sorting. If you want blank rows and 
columns to be included, you need to select the data to be sorted 
,rst and then undertake the sorting.

Check data for accuracy
You must always check your spreadsheets for accuracy. 
7is may include double-checking with your supervisor to 
make sure the data you have entered is correct.

As well as checking the values that are entered, you must 
make sure that any labels you have entered are spelt 
correctly and that you have formatted all data to suit 
organisational requirements.

Proofread

Proofreading is the process of carefully reviewing a 
document for any mistakes. To proofread a spreadsheet, you need to check for errors in 
values and labels.

To check values, you can compare the values you have entered with the values you were 
given. Make sure that you have not made any errors when copying values and that you have 
entered all the data in the correct places.
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To check errors in labels, you can use the Spelling function   under the Review tab. 7is 
will pick up words you have misspelt, but will not help you with product names or customer 
names and addresses. 7e function will also not help where a word is spelt correctly but is 
the wrong word; for example, ‘they’re’ instead of ‘their’.

Make sure you manually check your spelling and cross-check it with any documentation 
you used to enter the data. For example, you may have been given a printout of all customer 
names that were to be entered. Once you have entered the customer names, check them for 
accuracy against the printout.

Validation rules

When creating a worksheet, you can add validation rules in cells to ensure that anyone else 
who adds data has to make entries in the correct format.

For example, you may want only numbers or dates to be entered into certain cells. To do 
this, you need to set validation rules in your worksheet.

Example: set validation rules

Follow these steps to set validation rules.

1. Open an Excel worksheet. Look at the following sample and enter the same data into your 

worksheet. This worksheet is to record product codes that have one letter and two digits. 

The month columns record the units of products sold in that month. Save the worksheet as 

‘Validation rules’.

continued …
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… continued

2. Select cells A5 to A12.

3. From the Data tab, select the Data Validation tool . You will see the 

following Data Validation dialog box. From this dialog box, you can set the criteria for what can be 

entered into the cells you have selected.

4. Select ‘Text length’ from the Allow box. This option enables you to decide how many characters 

or digits you will allow in a cell.

5. From the Data �eld select ‘between’ and in the Minimum and Maximum �elds enter ‘3’. This 

means only three digits or characters are allowed in the selected cells. Click OK to save these 

rules.

6. Now try to enter four digits into one of the worksheet cells. Excel should display the following 

message:

This message tells you that your entry is invalid, but it does not tell you what you should enter. 

You can change the error message to tell a user exactly what should be entered into a cell.

continued …
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… continued

7. Select the Data Validation tool again. From the dialog box, select the tab Error Alert.

8. In the Error message, enter ‘You must enter one character and two digits’. Click OK.

9. Now try to enter four digits into one of the worksheet cells. Excel should display an error message 

saying that you should enter one character and two digits. 

If you set a validation rule, always create an error message that helps your colleagues enter the 

correct data.
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Check calculations
When using formulas and functions, you need to 
make sure that the result you get is the result you 
want. If you are working under tight deadlines, it is 
easy to make mistakes, such as subtracting one cell 
from another instead of adding them. 

Always test your formulas and functions before using 
them in your spreadsheet. You can do this by using 
a calculator to work out the result. When you have 
designed a formula and used it in your spreadsheet, 
you can check the result against the result your 
calculator gave you.

You should also check the consistency of information 
against the original data and check that the cell 
references, mathematical operators (symbols) and functions used are correct. 

Sometimes this is as simple as giving the information you have produced to a colleague or 
supervisor to check in dra* form, before you complete the ,nal version. 

Follow instructions about content and format
7ere are o*en guidelines or instructions for producing a spreadsheet when completing 
tasks. 7ese may relate to the content of the spreadsheet or its format and layout. 

You may be asked to prepare a report about stock on hand and to arrange the data in 
product code order, highlighting the quantity on hand and the quantity on order. You may 
also be asked to check product codes with the product description.

7ese are speci,c instructions on how to produce the spreadsheet. If these instructions 
are not followed, it may delay the ,nal production of the spreadsheet. It may also aDect the 
eDectiveness of the report and/or the accuracy of information.

If you are not sure, it is always important to clarify instructions and ask questions about 
what else may be needed. If you have your own ideas on how the content or format of a 
spreadsheet could be improved, speak to your supervisor.

Practice task 4

1. Practise entering this data into a blank spreadsheet.

Name Address Phone number

Mary Buchanin 29 Green Rd, Altona 3018 9983 0194

Ginger Smith 988 City Rd, Melbourne 3000 9876 3939

Lionel Ha 1/23 Brown Rd, Laverton 3028 9762 8373

Ali Simoghin 21/1 Tree St, Williamstown 3016 9853 8391

 • AutoFit the column width to enable all the data to be viewed.

 • Sort the data from A to Z based on name.

 • Save the worksheet as ‘Customer contacts’.

continued …
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… continued

2. Look at these examples of a worksheet and documentation used to enter data.

Customer accounts worksheet

Customer documentation

Customers Balance

Smith 55.00

Carter 4,000.00

Andrews 3,455.00

Phillips 3,000.00

Elliot 2,500.00

Franks 5,000.00

Luie 34.00

Cross-reference the worksheet with the customer documentation. Count how many errors there 

are in the worksheet.

3. What should customer Smith’s new balance be?

4. Recreate the ‘Customer accounts’ worksheet with accurate information.

5. Select cells B5 to F15 from the ‘Validation rules’ worksheet from the previous example. This 

covers all the values to be entered under the �ve months. Add a validation rule to these cells that 

ensures only numbers can be entered into them. Write an error message to help colleagues if 

they try to enter the wrong data. Test your validation rule to make sure it works.
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When you have created a spreadsheet, you will ,nd  
that some adjustments are required before the 
spreadsheet can display data to organisational 
requirements. 

For example, you may have to add columns and rows 
to enter new data, or resize columns and rows to ,t 
data that has already been entered.

Adjust column width
7ere are two main ways to adjust the width of 
columns in a spreadsheet. You can use Format 

 from the Cells tools on the Home tab to 
adjust the width of columns.

Alternatively, you can adjust the width manually by dragging the column to the required 
width, or Excel can automatically adjust the width for you.

Steps to manually adjust column width

 • Open the ‘Current clothing’ worksheet.

 • Move your cursor to the vertical line between the column headings. The 

cursor should change into a two-headed arrow.

 • Click and drag the two-headed arrow until the column is the required 

width.

 • Select another column that needs resizing.

 • Move your cursor to the vertical line between the column headings until 

the cursor changes into a two-headed arrow.

 • Double-click on the vertical line. Excel will choose the best �t based on the 

largest cell entry in the column.

 • Save the worksheet.

2B Use software functions to format spreadsheets
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Adjust row height
You can use Format   from the Cells tools on the Home tab to adjust the height 
of rows.

You can also adjust the height of rows manually by following these steps: 

• Move the cursor to the horizontal line between the row numbers. 7e cursor should 
change into a two-headed arrow.

• Click and drag the two-headed arrow until the row is the required height.

• Select another row that needs resizing.

• Move your cursor to the vertical line between the row numbers until the cursor changes 
into a two-headed arrow.

• Double-click on the vertical line. Excel will choose the best ,t based on the largest cell 
entry in the row.

• Save the changes.

Example: insert a column

The following steps show how to insert a new column.

1. Select Column E, called ‘End pro�t’.

2. Go to the Home tab and select the down arrow on Insert from the Cells tools. Select Insert Sheet 

Columns. A new column will be inserted to the left of ‘End pro�t’.

3. Select cell E4, which will become the label of the new column.

4. In the formula bar, enter ‘Tax’. This column is to calculate the tax on monthly income. 

5. It should look like the following example. Save the changes and close the worksheet.

To add a new row, from the Home tab, select the down arrow on Insert  from the Cells 

tools. Select Insert Sheet Rows. A new row will be inserted above.

To delete a row or column, select the down arrow on Delete  from the Cells tools. Select 

the appropriate option (that is, column or row) to delete.
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Alignment within cells
As discussed previously, text and values align diDerently within cells by default: text aligns 
to the le*, numbers to the right. 

To adjust the horizontal alignment of data within a cell, simply select the cell or cells 
and choose the appropriate alignment tool from the Home tab.  Horizontal 
alignment options include le*, centre and right.

7e alignment of data within a cell can also be adjusted for the height of the cell. 7e default 
is to align the text to the bottom of the cell. Data can be aligned to the top, centre or bottom 
of a cell. Text can also be oriented to be on an angle. 

To adjust the vertical alignment of data within a cell, simply select the cell or cells and 
choose the appropriate alignment tool from the Home tab.  

Example: merge and centre

Another common tool used to align cells is the Merge & Centre tool. This is commonly used to align 

a heading across the width of data in the spreadsheet. 

In the following example, the heading ‘Henry Lewis Consulting & Co’ and the heading ‘Sales results’ 

have been merged and centred across columns A to G (A:G).

To perform this action, each row is dealt with separately: 

1. First, the data from cells A1:G1 is selected and then the Merge & Centre tool 

 on the Home tab is selected. 

2. Next, the data from cells A2:G2 is selected and then the Merge & Centre tool is selected. This 

provides the data with a centred heading.
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Example: alignment of a spreadsheet

The default alignment for printing a spreadsheet is that the data is aligned to the left and top of the 

page in line with the margins. In many cases, especially in smaller reports, it is preferable to centre 

the data on the page both vertically and horizontally. 

To do this, �rst preview the spreadsheet to check what the information will look like before it is 

printed out. 

1. To preview, select Print from the File tab. 

2. Select the Page Layout tab. 

3. Select the Margins drop-down menu, then select Custom Margins.

4. Check the options to centre on the page – both horizontally and vertically. The display in the 

dialog box shows how the changes will appear in the spreadsheet. Select OK. When printed, the 

data will now be aligned vertically and horizontally on the page. 
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Orientation of a spreadsheet
When printing a spreadsheet, the default setting is set to print in portrait orientation. In the 
workplace, however, it is common for Excel reports to be printed in landscape orientation. 
In most cases, this is because the reports contain more data that spreads across the page, 
rather than down the page. 

To alter the orientation of your report, from the Page Layout tab select 
Orientation and then select Landscape.

If not all of your data appears on one page and some spills over to the 
next, you can force the data to be scaled to the size that you prefer (that 
is, 80% of size or ,t one-page wide by one-page tall). Scaling options 
are available under Settings in Print.

Simple calculations in Excel
Excel is used to calculate a variety of data; for example, in ,nancial reports, sales statistics 
and stock levels. Routine or simple calculations are o*en performed to calculate data.

An Excel calculation always starts with an = sign and can include any of the following 
mathematical operators:

• * (multiply) 

• / (divide)

• + (add)

• – (subtract) 

• % (per cent) 

• ^ (exponential)

Mathematical rules

7e mathematical rule of BODMAS is applied in Excel spreadsheets when performing 
calculations. 7at is, Excel calculates information in brackets ,rst, then orders, then division 
and multiplication, then addition and subtraction.

Calculations can be performed either on values (for example, 1, 2, 3) or on the cell reference 
(for example, A1). When calculating data, it is always better to use the cell reference (for 
example, A15), as opposed to the value (for example, 
783). 7is ensures that the data entered is accurate, 
as the information is taken directly from the cell 
instead of you having to retype it. 

It also assists by saving time – for instance, if the data 
in the cell changes, the calculation will be updated 
automatically as long as you used the cell reference.
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Formula e4ciency

Formulas in Excel are only as eCcient as the person 
entering the data. If you make an error when typing 
or entering the data or cell reference, the calculation 
will be incorrect. If you choose the incorrect operator 
(for example, *, +, /, –) for a calculation, the result will 
also be incorrect. 

Great care needs to be taken to ensure that the data 
entered is accurate. You need to manually check the 
values entered, as well as the cell references, and to 
be familiar with the operators and functions that 
you use.

7e use of formulas and functions saves a lot of time 
and makes the preparation of reports and statistical 
data eCcient.

As discussed earlier, it is always best practice to use cell references (for example, A1) where 
possible in calculations. 7is ensures that the data is accurate and also saves time if the data 
in the cell changes, as the calculation will be updated automatically. 

In addition, it is a better habit to use your mouse to point and select the cell reference, 
as opposed to typing it in, to ensure you have selected the correct information for the 
calculation. 

All calculations begin with the = symbol. If this is not present, Excel will not recognise the 
entry as a calculation, but will assume that it is simply a text entry.

Format spreadsheets
You can change the appearance of your spreadsheets to suit your organisation’s style and 
presentation requirements. 

You can adjust the appearance of a cell’s content by altering how it is aligned, its font and 
whether it has a border or pattern. If the cell has a numerical value, you can alter how this 
value is displayed by converting it into currency, a percentage, a fraction or a scienti,c 
number. 

Find out the style and presentation requirements for spreadsheets in your organisation. 

In the following exercises, you will be formatting a spreadsheet you have created.

Formatting your spreadsheet has a number of advantages:

• Creating an eCcient layout to make the information clearer and easier to read

• Making data input easier

• Making your spreadsheet comply with organisational style and presentation 
requirements
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Example: format labels

Earlier you learnt that text entered into a cell is called a label.

The following steps show how to format labels:

1. Open the ‘Current clothing’ worksheet.

2. Select the cells that contain ‘Current clothing label’.

3. From the Home tab, select Font to access the Format Cells dialog box.

4. The dialog box will display as follows:

continued …
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… continued

5. Select Garamond, Bold Italic, 18. Click OK.

6. Select cells A4 to F4. This should cover all the headings of your columns.

7. Using the Font tools, change the font selections. Select Garamond, Bold, 14.

8. Select cells A5 to A16. This should cover all the month labels.

9. Using the Font tools, change the font selections. Select Garamond, Bold, 12. Click OK.

10. The worksheet should now look like the following example. Adjust the column widths to suit the 

formatting.

Example: format values

Earlier you learnt that a number entered into a cell is called a value. 

The following steps show how to format values:

1. Open the ‘Current clothing’ worksheet.

2. Select cells B5 to F16. This will select all the cells where values have been inputted.

3. From the Home tab, select Number to access the Format Cells dialog box.

continued …
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… continued

4. The dialog box will display as in the following:

5. Under the Number tab, select Currency. Check the symbol and  

adjust if required. Click OK. Your values should now be 

formatted as currency. If some of your values are not 

displayed correctly, adjust the column width until they are 

clearly displayed.

Alternatively, you can use the Number Formatting tools to quickly 

adjust the way values are displayed.

Example: add borders and shading

You can make data in your spreadsheet more noticeable by using borders and shading. A border 

alters the appearance of the cell wall and shading alters the colour of the cell. 

The following steps show how to add borders and shading.

1. Open the ‘Current clothing’ worksheet.

2. Select cells A4 to F4. This should cover all the headings of your columns.

3. From the Home tab, select  in the Font section to access the Format Cells dialog box and then 

select the Fill tab.

continued …
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… continued

4. Select a pale colour and click OK. 

5. View the colour on your spreadsheet; if you don’t like it, change it now.

6. Select cells A5 to A16. This should cover all the month labels.

7. From the Home tab, select  in the Font section to access the Format Cells dialog box and 

select the Fill tab. Select the same pale colour you used for the column headings. Click OK.

8. Select cells A1 to F19. From the Home tab, select  in the Font section to access the Format 

Cells dialog box and select the Border tab. Look at the following example to help you:

9. Select a style of your choice, then Outline. Click OK.

10. To view your formatting, select the File tab , then select Print.

11. To return to your spreadsheet, select the Home tab. 
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Example: add a header and footer

You may need to adjust your spreadsheet by adding additional information in a header or footer. In 

this exercise, you are going to add a header and footer to your spreadsheet. 

The following steps show how to add a header and/or footer.

1. Open the ‘Current clothing’ worksheet.

2. From the Insert tab, select the Header & Footer tool . 

Now there should be a header section in your document for you to work in. There is also a new 

group of tools available for your use under a tab called Design.

You can type directly into the header section or you can use the new tools to insert useful 

information such as a date or page number.

3. To insert a footer, select the Go to Footer tool and type directly into the footer section, or use the 

Design tab tools.

4. Using these options, insert an appropriate header and footer into the spreadsheet.

5. Select Print from the File tab to preview the spreadsheet. If you are unhappy with its appearance, 

make appropriate changes.

6. Save and close your worksheet.

Practice task 5

1. Remembering the order in which Excel performs functions, work out the following calculations.

a) =23+24*2

b) =20+40*5

c) =100+2+30*4

d) =(15-5)*5

continued …
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… continued

2. Create this spreadsheet, which provides a summary of sales results for sales consultants at 

‘Henry Lewis Consulting & Co’. Then complete the tasks that follow.

 • Use Fill to create the list of months.

 • Alter the December �gures as follows:

 – Hannah: 5909

 – Joe: 2343

 – Fredrick: 1231

 – Simon: 2324

 – Carolyn: 4358

 – Nim: 13210

 • Save the document and name it ‘Henry Lewis – sales results’.

 • Practise using the alignment tools to adjust how the data sits within the cells – alter the width 

and height of columns and rows to see how using the alignment tools alters the viewed data.

 • Use the Merge & Centre tool to create headings for the spreadsheet.

 • Centre the data on the page both horizontally and vertically.

 • Print Preview the report.

 • Change the orientation from portrait to landscape.

 • Preview the report.

 • In a new column labelled ‘Summary monthly totals’, calculate the total sales �gures for each 

month. For example: =B6+C6+D6+E6+F6+G6. (Make sure you use the mouse to point and 

select each cell reference.)

 • Manually check the calculations using a calculator.

 • Change the font type to Arial 14 point (pt).

 • Bold the heading and the summary monthly totals.

continued …
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… continued

 • Italicise the month and sales consultant labels.

 • Adjust the column width as needed.

 • Use the Number Formatting tools to make sure all commission and total �gures are displayed 

in currency ($) with two decimal places.

 • Adjust the column width as needed.

 • Place a dark border around the outside of the data. 

 • Using the Fill tools, shade the list of names and associated data green and then shade the 

summary total a different colour. 

 • Shade the month names the same colour as the summary total. Shade the report heading a 

different colour. 

 • Preview your work. Save your changes.

 • Add a header with today’s date and time.

 • Add a footer that displays the page number.

 • Preview your work.

 • Save your changes and close.
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Formulas and functions in Excel are used to perform  
calculations. A formula is an equation that performs 
calculations on data. It is used to calculate numerical 
data. Formulas and functions can include cell 
references and mathematical operations such as 
addition and subtraction. For example, D5+E6 is a 
formula.

A function is a calculation that uses a mathematical, 
statistical or ,nancial operator. Excel provides a 
range of commonly used functions, such as SUM 
and AVERAGE. For example, SUM(B5:B17) uses the 
SUM function to add all the values in the selected 
cell range.

Depending on your organisation’s requirements, you may have to use values in your 
spreadsheets to generate new values, such as the GST of a product or service, or an 
increase in product prices. Formulas and functions allow you to generate new values using 
existing values.

Example: create a simple formula

The following shows how to create a formula to calculate values for the Pro�t column in the ‘Current 

clothing’ worksheet. When creating a formula in Excel, use the cell references of the cells you want 

to use in your calculations. For example, =A3+B3 adds the values in the cells A3 and B3.

1. Open your ‘Current clothing’ worksheet.

2. Select D5, the �rst empty cell under ‘Pro�t’. Enter the formula =B5–C5. Use the following 

example to help you:

3. Press the Enter key to perform the calculation.

continued …

2C  Use and test formulas to con=rm 
output meets task requirements
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… continued

4. Once you have a calculation, you can use Fill to perform calculations in the remainder of the 

column. Click and drag the D5 Fill handle down to D16. Your worksheet should now look like the 

following example:

5. The values in the ‘Tax’ column need to be calculated as 10 per cent of the pro�t. In E5 enter the 

formula =10%*D5 (this will give you 10 per cent of the value in D5). Look at the following example 

to help you:

6. Press the Enter key to perform the calculation. Fill the calculation down to December.

7. Select F5, the �rst empty cell under ‘End pro�t’. Enter the formula =D5–E5. This calculation 

subtracts ‘Tax’ from ‘Pro�t’, giving you the ‘End pro�t’ values. Use the following example to help 

you:

8. Press the Enter key to perform the calculation. Fill the calculation down to December.
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Simple functions
Functions can be used in Excel to perform a variety of mathematical, statistical and 
,nancial calculations. As well as adding up values, functions can also determine values such 
as the maximum, minimum or average from a range of cells.

Look at the following information about Excel functions.

=SUM(range)

 └ This adds the values speci�ed within the brackets.

=MAX(range)

 └ This returns the highest value from the values speci�ed within the 

brackets.

=MIN(range)

 └ This returns the lowest value from the values speci�ed within the 

brackets.

=AVERAGE(range)

 └ This returns the average value calculated using the values speci�ed 

within the brackets.

=COUNT(range)

 └ This counts the number of items in the range.

=NOW()

 └ This inserts the current time and date.

=RAND()

 └ This inserts a random number between 0 and 1.
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Example: use a simple function

The following steps show how to use a function to calculate totals in the ‘Current clothing’ 

worksheet. It shows how to use the SUM function to add the totals for each column of the worksheet 

that has a numerical value.

1. Select cell A18 on your worksheet and enter ‘Totals’.

2. Select cell B18. From the Formulas tab, select the Insert Function button . 

You will see the following Insert Function dialog box. Highlight SUM and click OK.

3. You will see the following SUM dialog box. As you have selected a cell at the end of a column full 

of numerical values, the SUM function is going to add all of these values together. Number 1 

shows the formula that the SUM function will use to make the calculation and the formula result 

is displayed at the bottom of the dialog box. Click OK.

4. Cell B18 should now hold the calculation of all income values added together.

continued …
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… continued

5. Select the cells C18, D18, E18 and F18 one at a time and use the SUM function to add the 

values of their corresponding columns. Your worksheet should now look similar to the following 

example:

AutoSum

7e AutoSum icon  is under the Home tab in the Editing grouping. AutoSum enables 
you to add values automatically using the SUM function. Simply select the range of values 
that you want to calculate and click the AutoSum icon.

Use the Fill handle  to repeat the sequence of the function.

Relative and absolute cell references
7e cells in an Excel spreadsheet are all relative to each other. 7is means that if you place a 
value in one cell and then move it, the values will alter as the cell collects information from 
other cells around it. 

For example, the totals you calculated for each of your columns may need to be moved to 
another part of the spreadsheet. However, if you move these totals to another location, their 
values will alter as the cells are no longer reading information from the cells immediately 
above them. 7is kind of reference is called a relative reference. 

To make the values remain the same wherever you place them in the spreadsheet, you need 
to make the reference absolute. Relative references change when you copy and move them, 
and absolute references do not change. 

To make a cell reference absolute, you need to place the $ symbol in the reference. Here is an 
example of the diDerence between a relative reference and an absolute one.

Type of reference Formula example

Relative =C5+B5

Absolute =$C$5+$B$5
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Example: create an absolute cell reference

The following steps show how to create an absolute reference:

1. Open the ‘Current clothing’ worksheet.

2. Select B18, which should be the ‘Income’ total.

3. In the formula bar you will see =SUM(B5:B17). Click in between the 

B and the 5. The formula will turn blue. Press the F4 key.

4. The formula will now read =SUM($B$5:B17). The B18 reference is 

now absolute.

5. Repeat the absolute cell reference process with the C18, D18, E18 

and F18 references.

Test your absolute reference creation by copying and pasting any of your absolute references to any 

empty cell. The value of the absolute reference you choose should remain the same wherever it is placed.

Test, adjust and con=rm formulas
It is important that the formulas used within a spreadsheet are appropriate for the data that 
needs to be produced and that they can be tracked for errors.

7is is where it is important that cell references are used. When cell references are used, it is 
possible to trace calculation errors within a report.

Identify errors

Excel has many features to assist you in identifying errors. 

First there is an alert that appears if there is an inconsistency in a formula. Look at the 
following example:

If you select the cell with the alert and hold your pointer over the green triangle symbol that 
appears, you will notice that a help bubble appears and explains the error that has been 
identi,ed by Excel.

7is helps you investigate and compare this formula to other similar formulas in the 
spreadsheet to ,nd out where the problem might lie and ultimately ,x the error.

Once you have investigated the error, you can choose the option to ignore the warning if 
there is no error. 7is will remove the green error Lag from the spreadsheet.
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Formula auditing tools

Formula Auditing tools are located under the Formulas tab. 7ey are useful when you are 
investigating errors and working out how to ,x them.

Of particular use is the Show Formulas tool, which changes the view so you can reveal or 
hide all the formulas in the spreadsheet. 

Another useful tool is the Trace Precedents tool, which shows where the data in the 
calculations comes from. To use this tool, you ,rst need to select the cell that contains the 
error and then select Trace Precedents. 7e spreadsheet will show preceding connections, 
as per the following example:

Check calculations

As discussed earlier, it is important that you also undertake manual checks as necessary. 
7is means checking values against the original data, using a calculator to verify results and 
discussing problems and calculations with colleagues and supervisors. 

7e case study in Practice task 6 shows how important it is to check your calculations. You 
should also consult your supervisor or manager about the calculations and results your 
spreadsheet has recorded.

Task requirements

Most organisations have developed policies and procedures for how reports are to be 
presented. Paying attention to the presentation of your document will enhance the reader’s 
ability to understand it. 

It is also important to ensure that the contents of any reports you are producing are 
accurate. 

As part of the production process, it is necessary to check all information, including:

• names, addresses and phone numbers

• product information and pricing

• dates

• reference details (such as customer number, product code)

• spelling

• ,gures and calculations

• document-speci,c facts (such as summary totals, highlighted information for action or 
review).
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Check information

If the information contained in the spreadsheet is 
not accurate, it can cause problems for the company 
that you represent. For example, you might work for 
a retail outlet and be asked to keep a record of daily 
sales. You might accidentally mistype Monday’s 
daily sales as $43,000 when it should have been 
$4,300. 7is would aDect not only the spreadsheet 
that you are preparing, but other ,nancial reports 
that determine pro,t and loss. 7is could then aDect 
other decisions that management may make; for 
example, the number of staD required to work on a 
particular day.

Taking the time to check information and making 
sure that it is correct helps to save time and improve 
oCce eCciency. Checking information and report requirements with colleagues, supervisors 
and managers assists in the preparation of reports that meet the organisation’s needs.

Practice task 6

1. Enter this data into a new worksheet, then complete the tasks that follow.

 • Calculate the January commission using cell references; for example, =B3*C3 will calculate 

Mary’s January commission.

 • Using AutoSum, calculate the total of the January commissions.

 • Using the MAX function, calculate the highest commission.

 • Using the MIN function, calculate the lowest commission.

 • Using the AVERAGE function, calculate the average commission.

 • Save the �le as ‘January sales commissions’.

continued …
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… continued

2. Read this case study, then complete the tasks that follow.

Case study

Daisy works as an administrative assistant in a large of�ce. One of her tasks is to create 

spreadsheets. Her supervisor has asked her to create a spreadsheet with the cost price and 

selling price of various products. Daisy then has to calculate the new price of stock after a 20 

per cent discount. To calculate the discount of the value in B5, she uses =10%*B5. To calculate 

the ‘Sale price’ to be shown in D5, she uses =SUM(B5:C5).

Daisy’s results look like this: 

a) Explain the mistakes Daisy has made in her calculations for the ‘Discount’ and ‘Sale price’ 

columns.

b) What could be the consequences of the organisation using this data?

continued …
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… continued

c) Rewrite the functions for the ‘Discount’ and ‘Sale price’ columns.

d) Describe what Daisy could have done to make sure her calculations were accurate.



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

63

Topic 2
Create simple spreadsheets

You may need to access help when producing Excel spreadsheets. You may not understand 
how an Excel function works or you may need help operating a printer. 

Whatever the problem, you need to have a plan in place for dealing with the unexpected. 
Organisations usually have a number of ways of dealing with so*ware or hardware 
problems. 7ey may have manuals or training booklets for you to look at or they may have a 
help desk for employees.

Here are some examples of possible problems.

Hardware

 └ Your monitor stops working.

Software

 └ Your software has been upgraded and you are unsure how to use it.

Formatting

 └ You want to add borders and colour shading to your spreadsheet.

Layout

 └ You want to change the orientation from portrait to landscape.

Formulas

 └ You want to know why a formula seems to be giving the incorrect 

answer.

Function

 └ You want to know how to use the AVERAGE function.

Printing

 └ You want to know how to print to the colour printer.

2D Overcome problems with spreadsheet 
design and production
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Use Excel Help
If you are working in Excel, you can use the 
Help facility  . Full access to the Help facility 
requires you to be connected to the internet. 
However, you can access standard Help facilities 
without being online.

To use Help, simply click on the Help facility and 
either use the chapter index or type a keyword 
about the information you need help with into 
the Search bar.

You can also use F1 to access the Help facility.

Use tool buttons
Each time you move your mouse pointer over a tool button, 
it will display a Help bubble that tells you what the button 
is used for.

For instance, from the Home tab, if you move your pointer 
over the font tool the arrow is pointing to, you see this Help 
message:

Use manuals
Excel so*ware comes with user manuals that 
describe the so*ware’s features and provide step-by-
step instructions for carrying out diDerent functions. 
You can ,nd manuals in paper-based and online 
formats. Look for paper-based manuals in your 
organisation or your local library.

7ere are many websites where you can ,nd 
information about Microso* OCce applications. 
7ese websites contain frequently asked questions 
(FAQ) and solutions to common problems. You 
can also download updates, tools and any ,xes that 
Microso* has developed for so*ware problems. 

You may ,nd the following websites useful:

http://support.microso*.com

7is is Microso*’s main site for ,nding help to solve problems for all Microso* products. 
You can ask questions online and download ,les, including service packs, drivers and 
patches. 7is site also gives you access to the Microso* Knowledge Base, which oDers help 
for all aspects of problems that can be experienced when using OCce 2013.

http://oCce.microso*.com

7is site provides resources for all OCce applications. It has news and announcements and 
useful ,les that you can download. If you are connected to the internet, you can open this 
site by choosing Help and connecting to OCce.com.
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Use training booklets
7ere are many ways to learn about computer functions and so*ware packages. You may go 
to a training course to learn a particular computer function or a supplier may instruct you 
in the use of a piece of equipment. You may receive training when you start a new job.

Training courses usually provide a comprehensive set of instructions or notes that are worth 
keeping for future reference.

Practice task 7

Read the case study, then answer the questions that follow.

Case study

Chinh works as an administrative assistant in a small manufacturing organisation. One of his 

tasks is to create Excel spreadsheets for his supervisor.

When creating spreadsheets, Chinh often needs to use Excel Help to answer questions about 

software functionality. If he is unsure of a screen icon’s function, he points to the icon with his 

mouse and reads the Help bubble.

Recently Chinh attended a two-day Excel training course at a local community centre. He kept 

the training booklet given out and stores it on his bookshelf. It has a handy index at the back 

for quick solutions to problems. He has also photocopied pages from various manuals he has 

found around the of�ce and placed them in a Help folder on his desk.

Sometimes Chinh experiences software function problems that cannot be solved using Excel 

Help. He then uses Microsoft’s support website to �nd a solution or refers to the paper-based 

material he has gathered.

1. If Chinh experiences software functionality problems, where does he go for help?

2. Describe how Chinh uses paper-based manuals for help.

3. If you experience a software problem when creating a spreadsheet, describe the steps you 

should take to solve the problem.
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Summary

1. Organisations use Excel spreadsheets to store and perform calculations on numerical 
data. 

2. You may need to adjust the height and width of columns and rows to suit the data.

3. Formulas and functions are used in Excel to perform calculations.

4. When using formulas and functions, you need to make sure that the result you get is the 
result you want. Always test your calculations.

5. You can change the appearance of your spreadsheet to suit your organisation’s style and 
presentation requirements.

6. Always check the data to make sure it is accurate and there are no spelling or 
presentation errors.

7. To solve problems when producing a spreadsheet, make sure you have access to paper-
based or online help.

8. You can ask Excel for help at any time by pressing the F1 key.
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7is learning checkpoint allows you to review your skills and knowledge in creating simple 
spreadsheets.

Part A
Read this product documentation and product pricing worksheet, then answer the questions 
that follow.

Product documentation

Product Code Price (before GST)

E334 1700.00

E343 1200.00

E788 1500.00

E708 1000.00

E356 8000.00

E376 2500.00

Product pricing worksheet

Learning checkpoint 2 
Create simple spreadsheets
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1. Proofread the product pricing worksheet against the product documentation. What 
major errors has the person entering the data into the worksheet made?

2. On the worksheet, the actual price of product E343 is given as $1,530.00. What is the 
correct actual price of this product?

3. What is the correct GST for product E788?

4. What is the correct actual price for product E356?

5. Which value on the worksheet is correct?

6. Write a short paragraph describing the consequences of entering incorrect data. Give a 
suggestion for how to prevent incorrect data being entered.
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Part B
Recreate the following spreadsheet.

• Use Fill to enter the days of the week

• Enter the values underneath the days

• Format the labels to make data input easier

• Add a border around the ‘Day Totals’ and the ‘Week Total’

• Use the following example to help you. Use Excel Help facilities where necessary to 
assist you in producing the spreadsheet.

• Use a calculator to work out each of the daily totals. In B11, write a formula that 
calculates Monday’s totals. Make sure your formula gives the same results as your 
calculation.

• Repeat this to add a day total for every day.

• Use a calculator to add up all the daily totals. In B13, write a formula that calculates the 
weekly total. Make sure your formula gives the same result as your calculation.

• Print Preview your spreadsheet. Adjust the alignments of your labels and values until 
you are satis,ed with how your spreadsheet looks. Print out your spreadsheet. 
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Part C
Recreate the following ‘StaD Salaries’ spreadsheet by entering the data into each cell. 7e 
‘Hourly Rate’ is how much each person is paid per hour and the ‘Weekly Hours’ are how 
many hours are worked per week. Use Excel Help facilities to assist you, as needed, to 
produce the spreadsheet.

• Format all the labels so they are Arial, Bold, 10. Add a pale colour to all the cells with 
labels. Add a border to the cells ‘StaD Salaries’ and ‘Total Salaries’.

• Use a calculator to work out how much salary Joanne will receive. In D5, write a formula 
that calculates Joanne’s salary. Make sure your formula gives the same results as your 
calculation. Use Fill to add the values for the remaining salaries.

• All staD are going to receive a salary raise of 15 per cent per week. 7e ‘Salary Rise’ 
column is going to show 15 per cent of the values in the Salary column. Use a calculator 
to work out 15 per cent of Joanne’s salary. In E5, write a formula that calculates 15 
per cent of Joanne’s salary. Make sure your formula gives the same results as your 
calculation. Use Fill to add the values for the remaining salaries.

• 7e ‘New Salary’ column is going to hold the value of the ‘Salary’ and ‘Salary Rise’ 
columns added together. Use a calculator to add up Joanne’s new salary. In F5, write a 
formula that adds up Joanne’s new salary. Make sure your formula gives the same results 
as your calculation. Use Fill to add the values for the remaining salaries.

• 7e value in B15 is going to contain all the ‘New Salary’ values. Using a calculator, add 
up all the new salaries. In B15, write a function within a formula to add up all the ‘New 
Salary’ values. Make sure your formula gives the same results as your calculation. Make 
the cell reference of B15 absolute.

• Print Preview your spreadsheet. Adjust the alignments of your labels and values until 
you are satis,ed. Print out your spreadsheet.
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A chart is a graphical representation of selected worksheet information. Charts are used 
to visually represent numerical data. It is usually easier to analyse columns and rows of 
numerical data if they are displayed in a chart. Charts make it easy to spot trends, highlight 
changes and compare ,gures over a period of time.

7e best type of chart to use will depend on the type of data being converted into a chart; 
for example, you might choose a pie chart to show one data series and a column chart 
to show multiple data series. How you format a chart will depend on organisational and 
task requirements. Formatting a chart enhances the presentation and readability of the 
information.

In this topic you will learn how to:

3A Select a chart type and design to enable valid representation of numerical data

3B Create charts

3C Use formatting features to modify the chart type and layout
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When producing charts, it is important to follow both  
organisational and task requirements. An 
organisation may have a set preference for the type of 
charts it uses. For instance, it may prefer to use 
column charts as opposed to line charts because it is 
easier to analyse the information. An organisation 
may also use certain colour codes for the 
presentation of data; if this is the case, these rules 
should be followed to ensure consistency of image.

Task requirements can depend on a set of 
instructions and protocols in the production of 
charts. You may be asked to prepare a summary 
report of monthly sales as well as a chart. If this is 
the case, you need to produce two documents. If the 
policy is that a certain type of chart design is used for 
the production of various reports, you need to do this. 

If you have any suggestions for improving the readability and analysis of charts and their 
associated data, discuss them with your supervisor or manager.

Chart types and their features
If you are using an Excel spreadsheet, you will be able to display your data in a chart. 7e 
types of charts you can select include area, bar, column, pie, line and scatter. 

Charts are visually appealing and make it easy to see data and recognise patterns and 
trends. 7ey make it easier to absorb information at a glance. 

Example: chart

The following example shows the percentages of types of cakes sold in a bakery presented in a pie 

chart. It is easier to look at the cake shop data in a chart, rather than in the columns and rows of a 

worksheet.

Charts are linked to information contained in the selected cells. That means if the cell data is 

updated (for example, the value 45 changes to 88), the chart is also updated accordingly.

3A Select a chart type and design to enable 
valid representation of numerical data



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

73

Topic 3
Produce simple charts

Choose and design a chart
7e kind of chart you choose and its design should 
reLect your organisation’s needs. In this section, you 
will look at diDerent types of charts and consider 
some of their most appropriate uses.

Area chart

Area charts are used to demonstrate changes over 
time. For instance, they may be used to show and 
compare changes to sales over a given time. Area 
charts highlight total values across a time line. 

7e following example shows how yearly real estate 
sales ,gures vary for diDerent outlets.
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Bar chart

A bar chart displays information as a series of horizontal bars. 7ese charts are useful for 
comparing data arranged in columns or rows. Bar charts show the diDerences between 
individual items.

7e following example shows how monthly sales vary for diDerent departments of a 
retail outlet.

Stacked bar chart

Use a stacked bar chart to compare the values of individual totals to a total across categories. 

7e following example compares monthly department sales ,gures, as well as the total 
overall amount.
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Column chart

A column chart has vertical columns and is useful for comparing separate types of data 
from a data series. 

7e following example shows how rainfall data can be used in a comparison.

3-D column chart

If you prefer the 3-D look for your column chart, choose 3-D when making your chart 
selection.

Use a stacked column chart to compare the values of individual totals to a total across 
categories. 

7e following example compares monthly rainfall for Melbourne and Sydney, as well as the 
total overall amount.
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Pie chart

A pie chart shows a data series in percentage segments. It is useful for showing data as a 
percentage of a whole. Pie charts are commonly used to show which products are selling or 
how much market share an organisation enjoys. 

7e following example of a two-dimensional pie chart shows the market shares of ,ve health 
food companies.

3-D pie chart

If you prefer the 3-D look for your pie chart, choose 3-D when making your chart selection.
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Line chart

A line chart shows the movement of values in a data series using single or multiple lines. It is 
useful for showing how the values of a data series can change over a period of time. 

7e following example uses a line chart to show rainfall in Melbourne and Sydney.

Scatter chart

A scatter chart is used to compare and arrange data to analyse the relationships of 
information. A scatter chart displays clusters and is commonly used for statistical 
comparisons. 

7e following example uses a scatter chart to display and analyse estimated sales and 
actual sales. 
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Practice task 8

Read the scenario, then answer the question that follows.

Scenario

Hemline Miller is a boutique fashion chain specialising in womenswear. Each outlet regularly 

provides a monthly report on trade, including sales �gures, customer numbers and quantity of 

stock sold. Liza Guilano, the business owner, is happy with these reports. However, she realises 

that some of the newer store managers are �nding the information cumbersome to interpret. 

Liza has decided that in addition to the reports, she would like to trial preparing the information 

in chart form – a chart that compares the data for each of the outlets. She believes that a 

graphical representation of the data will be easier for the managers to decipher and compare.

Liza asks you, the of�ce manager, to prepare an example of how the data would be presented in 

chart form. She asks you to use bright colours in the charts, as this complements the style and 

colour range of the business. She also asks you to present the information in column form, with 

values and stores identi�ed in the chart. It is important that there is a heading on each of the 

charts to clearly identify the information that is being reviewed.

What are the organisational and task requirements for producing the chart/s?
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Before you start to produce charts, become familiar with the terms used when referring to 
parts of a chart. 

7e following information explains the meanings of terms you need to know.

Axes

An axis is a line that labels the 

information in a chart according to 

the labels in the columns and rows 

of your spreadsheet. Axes (the 

plural of axis) provide a reference 

for measurement or comparison of 

the data in the chart. Most charts 

have a vertical axis (known as 

the Y axis) and a horizontal axis 

(known as the X axis).

Categories

Categories are the names that are 

placed along the X axis of a chart 

and are determined by the labels 

in your spreadsheet.

Data range

The data range is the selection 

of values you choose from a 

worksheet to place in a chart; for 

example, all the numbers in one 

row or one column of data.

Legend

The legend is the key used to 

identify the various data series. If 

you include the series labels from 

your worksheet, Excel will add 

these to the legend. Otherwise the 

legend will display series 1, series 

2 and so on.

Produce a chart
To produce a chart, you must ,rst enter data into a worksheet. You then need to select the 
data you want to appear in the chart. Use the Insert tab and select the appropriate chart for 
the data that you wish to present. A chart is linked to the worksheet it is created from, so if 
you alter the data in the worksheet, the chart will be updated.

To produce the chart, choose the data that you want to present. Select the data by either 
clicking and dragging over it with the mouse, or clicking on the cell to select it and then 
using the Shi1 key and arrows on the keyboard to select the data. 

7e following example shows what selected data looks like.

3B Create charts
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Example: choose and produce a chart

The type of chart you choose will depend on your organisational requirements. 

The following steps show how to produce a column chart.

1. Open Excel and enter the following data into a worksheet. Save the worksheet as ‘Company cars’.

2. Select cells A4 to E9. This selection should cover all the labels and values. This selection has now 

become your data range. Do not include any blank rows or columns in your selected cell range.

3. From the Insert tab, select the appropriate chart you wish to display; for example, ‘Column’.

continued …
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… continued

4. The chart will now display as an object in your spreadsheet.

5. To move the chart to a separate sheet within the workbook, select Move Chart  from the 

Design tab. A dialog box will appear; select to place the chart in a new sheet  

and then name it appropriately (for example, ‘Cars by state’).

6. The chart will now have a separate sheet in the workbook. If you look at the worksheet names, 

you will notice that the chart now appears there.

7. If the data you want to include in a chart is not in adjacent rows and columns, use the Ctrl key to 

make multiple selections in different locations on your worksheet.

8. Trendlines can be added by selecting the Trendline tool from the Layout tab in Chart tools.
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Practice task 9

Create this spreadsheet data for Hemline Miller that shows sales, customer numbers and quantities 

sold. Save the document as ‘Hemline Miller January report’.

1. Create a column chart that compares the sales data. 

2. Create a scatter chart that compares customer numbers with quantity sold. 

3. Create pie charts for sales, customer numbers and quantity sold.
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A*er you insert a chart into your worksheet, you will notice that two new tabs appear when 
you click the chart: Design and Format. 7e Layout tools also appear next to the chart.

Chart tools
Design tools enable you to change the type of chart selected, choose the style and layout, 
alternate the view of data between row or column, and check or adjust the data selected.

Formatting tools enable you to alter the general appearance of the chart such as colour, font 
type and font size.

7e data table is the data contained in the spreadsheet that the chart draws its 
information from. 

Layout tools enable you to add to and adjust the appearance of the chart by adding titles, 
labels, gridlines and so forth.

3C Use formatting features to modify 
the chart type and layout
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Why format your chart?
You need to format your chart depending on the 
organisational and/or task requirements. Formatting 
the chart can also enhance the presentation and 
overall readability of the information.

Balance the time taken to prepare the chart with the 
required output medium. For example, if you do not 
have a colour printer or are not presenting the charts 
electronically, it is not necessary to spend a lot of 
time selecting colours. You only need to ensure the 
font type and size are appropriate and the chart is 
well presented.

All parts of the chart are separate components and 
can be formatted and adjusted as appropriate. To 
select part of the chart, point and click to select it 
and then use the tool bar or right-click mouse shortcut menus to make appropriate changes. 
Formatting of the chart can relate to colour choice, using gridlines, adding borders, adding 
titles and labels, font size and type, and even changing the choice of chart type to be used.

Titles in a chart are separate objects and can be moved around and resized by clicking and 
dragging with your mouse.

Example: format your chart

Once you have created a chart, you need to format it to suit your organisational requirements. This 

may include formatting the data range, text and legend, or adding a pattern to the chart area.

The following steps show how to format a chart.

1. Open the ‘Company cars’ chart.

2. Click inside any of the Adelaide data series columns. Right-click your mouse and select Format 

Data Series. You will see the following Format Data Series dialog box:

continued …
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… continued

3. Click Fill and select Gradient 
ll, then choose a preset colour and click on Close. You will notice 

that the Adelaide data now has a shade effect in the chart. If you want to change the look to 

something different, select Picture or Texture 
ll instead, then select an appropriate texture.

4. Repeat this process to choose Gradient �lls for the Melbourne, Perth and Sydney columns. 

5. The Plot Area is the space behind the columns. Right-click in the Plot Area and select Format 

Plot Area. The Format Plot Area dialog box will appear. From Fill, select Solid Fill and choose an 

appropriate colour. Click Close.

6. The Chart Area is the space behind the legend and the chart labels. Right-click in the Chart Area 

and select Format Chart Area. The Format Chart Area dialog box will appear. From Fill, select 

Solid Fill and choose an appropriate colour. Click Close.

7. To add a border to the Chart Area, right-click and select Format Chart Area. From the Format 

Chart Area dialog box, select Border colour, choose Solid Line and make the colour black. Click 

Close.

8. To add a chart title, select Chart Title and then Above Chart from the Layout options. Type 

‘Company cars’ in the text box.

9. To add axis titles to the chart, select Axis Titles from the Layout options and add a horizontal 

title (‘Make of car’) and vertical title (‘Number of cars’).

10. To format the text in the chart title, select the Chart Title and use the formatting tools on the 

Home tab. Format the title to be Arial, Bold, 16. Format the labels of the axes (‘Make of car’ and 

‘Number of cars’) to be Arial, Bold, 12. Format the legend to be Arial, Bold, 10.

11. To add data labels to the chart, select Data Labels from the Layout options, then select an 

appropriate position in the chart (such as centre). This example displays the number of cars for 

each model on each data range.

12. Format gridlines in the chart by right-clicking and selecting Format Major Gridlines. Select Line 

Style and choose a dashed line style. Click Close.

continued …
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… continued

13. The chart should appear similar to the following example:

Practice task 10

Open your document ‘Hemline Miller January report’. Format the charts (using bright colours, 

gradients and textures) to include relevant titles and labels as follows:

1. Column chart – include the title ‘January – sales’.

2. Scatter chart – include the title ‘January – customer numbers vs quantity sold’.

3. Pie charts – include relevant titles for sales, customer numbers and quantity sold, as well as data 

labels showing percentages of the total.
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Summary

1. A chart is a graphical representation of selected spreadsheet data.

2. Charts are visually appealing and make it easy to display comparisons, patterns and 
trends in data.

3. 7e type of chart you choose to display data will depend on organisational and task 
requirements.

4. When you insert a chart into an Excel worksheet, two new tabs appear – Design and 
Format. 7e Layout options also become available.

5. Each component of a chart can be formatted and adjusted individually as needed.

6. In a workbook, a chart can appear either as an object in a worksheet or in a separate 
worksheet.
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7is learning checkpoint allows you to review your skills and knowledge in producing 
simple charts.

Part A
Explain the type of data most suited to each of these chart types:

1. Pie

2. Column

3. Stacked bar

4. Line

Part B
Produce a chart that suits your organisation’s needs. Talk to your supervisor to identify any 
existing data, or data that you could enter, to create a chart. If it is not possible for you to 
use data from your organisation, complete the following activity based on information from 
past employment or from your life experiences; for example, a budget or savings plan.

• Choose a chart type that best suits the data you have entered. Create the chart.

• Format each part of the data range with a diDerent colour. Add a gradient, texture or 
pattern to each data series.

• Format the title and legend to increase their readability.

• Print out your chart. 

Learning checkpoint 3 
Produce simple charts
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Part C
Read the following data and complete the tasks that follow.

• Choose a chart that best suits this data. Create the chart.

• Save the worksheet as ‘Sales ,gures’ and store it in an appropriate place.

• Format each of the data ranges with a new colour. Add a gradient, texture or pattern to 
each data series.

• Format the title and legend to increase readability.

• Print out your ‘Sales ,gures’ chart. 
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In the workplace, it is important to produce quality spreadsheets and charts that adhere to 
organisational and task requirements. Make sure that the ,nal spreadsheet and chart have 
been thoroughly checked and proofread before sending or presenting them, so the correct 
message and company image are delivered to the appropriate person/s. 

For example, if you have not spellchecked a document and it contains errors, or if you use 
an old product code, this sends a message to the receiver of the information. 7ey may think 
that you, and the company or department, do not really care about the matter contained in 
the report. 

In this topic you will learn how to:

4A Preview, adjust and print spreadsheets and accompanying charts

4B Ensure data input meets time lines and requirements for speed and accuracy

4C Name and store a spreadsheet, and exit an application safely
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When preparing spreadsheets and charts, it is  
important that you adhere to the required time lines 
and job instructions. If you believe that there needs 
to be alterations to either the time line or job 
instructions, you need to discuss this with your 
supervisor and/or the person who has requested 
the work.

Many businesses have strict deadlines for completing 
tasks – it may be that your manager needs a ,nancial 
report for a weekly meeting. Failing to meet the 
deadline and provide the required information may 
aDect other tasks.

Many spreadsheets need to be accessed by other 
people in your work team, so ensuring that you save 
,les appropriately will save time and improve oCce eCciency. Accessing spreadsheets is 
made easier by using appropriate ,le referencing and saving options.

Save ,les to the correct drive (for example, the network drive), the appropriate folder (for 
example, your department name) and appropriate sub-folders (for example, project name) 
and assign a ,le name that is relevant to the ,le (for example, ‘Sales report March 2016’).

Print your worksheet
Once you have created a workbook or spreadsheet, you will probably need to print it. Before 
printing, you need to make sure you have undertaken a number of checks.

First, make sure you have adhered to and met all organisational and task requirements for 
completing the spreadsheet. 7is incorporates instructions for information to be included, 
as well as formatting and layout of information. Proofread your spreadsheet and check 
all formulas and functions before printing. If needed, make appropriate adjustments to 
the data.

Many organisations follow a policy that spreadsheets are previewed and checked on-screen 
prior to printing. Even if this is not the current policy in your workplace, it is a good 
practice to include in your routine work processes.

It is also important that you do a Print Preview of the data prior to printing, as this can save 
time and improve eCciency. It reduces paper wastage and allows you to undertake a check 
of the data – ensuring accuracy of information and presentation.

4A Preview, adjust and print spreadsheets 
and accompanying charts
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Print Preview

The following steps show how to preview your work in Excel.

1. To preview your spreadsheet or chart, select the File tab , then Print.

2. The preview of the job will appear to the right of your screen and look similar to the following 

example:

Be careful when selecting multiple worksheets. If you have a number of worksheets active at 

one time, any data that you alter and input will be repeated on all of the selected worksheets. To 

deactivate multiple selected worksheets, simply click on one worksheet name. This will then become 

the active worksheet.
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Example: print a worksheet

The following steps show how to print a worksheet.

1. Open the document ‘Current clothing’.

2. From the File tab, select Print. The 

worksheet will be displayed exactly as it will 

be printed. 

3. Under Settings, select Landscape 

orientation and scaling of 135%. (Scaling 

allows you to adjust the size of the printout 

and make it larger or smaller on the printed 

page.)

4. Use the Settings to alter this from all pages 

in the document to only selected pages. 

Alter the printer you are using if necessary, 

then select how many copies you want to 

print. It is also possible to choose whether 

the multiple printed copies are collated. Click 

Print.

Example: print a selection from a worksheet

You may be dealing with a very large worksheet or your manager  

may have requested only some information from a worksheet. 

If this occurs, you may need to print part of a worksheet:

1. Open the ‘Current clothing’ worksheet.

2. Select cells A4 to B18. This should cover all the ‘Month’ and 

‘Income’ data.

3. From the File tab, select Print.

4. From Settings, select the �rst drop-down menu and Print 

Selection.

5. Click Print.
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Print a workbook

To print an entire workbook comprising multiple worksheets, follow the instructions for 
printing a worksheet, but in Print select Print Entire Workbook.

Example: print a chart

The following steps show how to print a chart.

1. Open the document ‘Company cars’.

2. Select the chart by clicking on it. Because 

this has been selected, only the chart will be 

previewed and not the data in the spreadsheet.

3. From the File tab, select Print. Your chart will 

be displayed exactly as it will be printed. Under 

the Margins drop-down menu, manually adjust 

the left and right margins by selecting Custom 

Margins.

4. Alter the printer that you are printing to if 

necessary, then select how many copies of the 

chart you want to print. Click Print.

You can adjust the size of the printout by altering 

‘Adjust to’ to more than 100% of normal size in the 

Page Setup dialog box available from Print.

Practice task 11

1. Open your document ‘Company cars’. 

 • Preview the spreadsheet. Check the appearance of the data and chart, and make any 

necessary adjustments prior to printing. 

 • Print one copy of the spreadsheet.

 • Close the �le.

2. Open your document ‘Company cars’. 

 • Select cells A4:B9; this will select only the make of the cars and Melbourne data.

 • Print only the selected data.

 • Close the �le.

3. Open your document ‘Company cars’. 

 • Select the chart only.

 • Print the chart.

 • Close the �le.

4. From your ‘Current clothing’ worksheet, print out the ‘Pro�t’, ‘Tax’ and ‘End pro�t’ columns, 

including the ‘Totals’. Adjust the size of your selection until it is 150 per cent of its normal size.
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Whenever you are given a work task, you need to plan  
a time line, which is a plan for how long it will take to 
complete a task. It also breaks the task into steps and 
details when each step must be completed.

Time lines will normally be pre-designated and 
depend on instructions given or dates when 
tasks need to be done by. 7is means that work 
you are completing needs to be ,nished within a 
speci,ed time.

You may have to create a spreadsheet to your 
manager’s speci,cations, which may include a 
deadline. 7e spreadsheet may be needed for a board 
or client meeting and if it is not ready on time, it will 
not be useful.

Find out when the spreadsheet is required and enter the date in your diary. Identify and 
plan the task requirements to work out how long it is likely to take. Careful planning means 
there will be no last-minute panic.

If you are developing a spreadsheet for someone else, always clarify exactly what is required; 
for example, are formulas needed and do you have to create a new column? If you have to 
write formulas, make sure you allow enough time to have them checked by your manager.

Time lines
Preparing a checklist can help you plan a work task. Creating spreadsheets will become 
easier once you are familiar with your organisation’s requirements.

Look at the following example of a checklist.

Task Deadline Requirements Completed

Create a 

spreadsheet 

for the 

manager

Thursday 

17 March

Enter product data.

Proofread the data.

Format the spreadsheet using the organisation’s style 

guide.

Create a new column named ‘Discount’.

Write a formula to calculate 10% of customers’ 

balances.

Create a column named ‘Sale price’.

Write a formula to calculate the new sale price.



4B Ensure data input meets time lines and 
requirements for speed and accuracy
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Enhance speed and accuracy
When producing reports and charts in Excel, it 
is important that you undertake tasks in a timely 
and eCcient manner. Keeping to time lines is one 
aspect; another is using the so*ware appropriately 
and eCciently to save time and ensure the accuracy 
of data.

Use shortcut menus (right-click mouse button) to 
bring up quick commands for undertaking actions. 
Use shortcut keys to undertake actions quickly (for 
example, Ctrl X to cut, Ctrl V to paste). Familiarise 
yourself with the tools available in the ribbons and 
the groups of tools under each tab. If you think 
there should be an easier way of doing something, 
there probably is. Search the Excel Help facility for 
assistance.

Use the numeric keypad on your keyboard for data entry of values. Although Excel is 
mainly used for entry of numbers, learning to improve your typing speed and accuracy can 
help. Learning to touch-type may be a way to improve your typing speed.

Organisational time lines
In a workplace, you will o*en be required to meet speci,c deadlines. Your supervisor may 
tell you what the deadline is for completing set tasks (for example, prepare a dra* summary 
report by 2.00 pm) or you may have regular deadlines for common tasks (for example, on a 
monthly basis, create a report of customers whose invoices are unpaid and overdue) or there 
may be ,nancial requirements (for example, a summary report of GST costs). It is important 
to adhere to organisational time lines for the eCcient running of the business.

If for some reason a deadline may not be met or you have conLicting work priorities, discuss 
this with your supervisor. However, do not leave it until the last minute. Your supervisor 
may be able to help you by making suggestions about how the deadline can be met or they 
may be willing to adjust the deadline.

Using a diary system and a to-do list can help you prioritise tasks and be aware of the time 
lines required for set tasks.

Time lines agreed with an internal or external client

Most organisations have a range of clients, who are either internal or external. Internal 
clients are those who work in the same organisation, such as work colleagues, people in 
other departments, managers and supervisors. External clients are those who are outside the 
organisation, such as customers and suppliers.

In many cases, time lines are set and agreed with your clients, both internal and external. If 
you agree to a deadline for completing a task, it is important that you meet it and if you can’t, 
speak to your supervisor and the client. Your supervisor may be able to make suggestions that 
you have not thought of to help you meet the deadline. Speaking with your client will allow 
you to discuss the issue/s with them and may help you to adjust the deadline.

Meeting a deadline demonstrates your competence in undertaking tasks; it also shows 
professionalism on the job. When deadlines are being set, be sure that they are both 
achievable and realistic.
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Time lines agreed with a supervisor or the person requiring the 
spreadsheet

In many cases, the time line for the completion of 
a task is set by your supervisor or another person. 
7ey may have certain deadlines to meet as well and 
this is why they are setting a certain time frame for 
the completion of the task that they have requested 
from you.

If you are asked to complete a task, always ask 
what the deadline is. If you have a high workload 
at present, ask them if the deadline that they have 
speci,ed is de,nite or if it is able to be negotiated. 
In many cases, there will be room for negotiation. 
If it cannot be negotiated, explain your conLicting 
priorities or discuss them with your supervisor, and 
try to work out a happy medium or see if you can get 
additional assistance so you can meet your other deadlines. Your supervisor may be able to 
pass some of your other work on to another colleague to complete.

Always ensure that the time line set is realistic and achievable, and that if there are any 
problems, you discuss them with your supervisor and/or the person who requires the 
spreadsheet.

Practice task 12

Read the case study, then answer the questions that follow.

Case study

Charles works as a personal assistant to a manager in a large organisation. One of his tasks 

is to create spreadsheets. Charles is asked to create a spreadsheet with information about 

products. He is given a lot of information about the products including their codes, their prices 

and how many had been sold over the last �nancial year.

Charles clari�es with his manager the exact information that is needed. He �nds out that his 

manager wants to know how much every product costs in order to calculate a 10 per cent 

discount off all stock for a stocktake sale. His manager also wants to know how much the 

products would cost with the discount. Charles is given two days to produce the spreadsheet. 

Charles selects the information that is needed in the spreadsheet. He breaks the task into 

parts and creates a checklist for every task that needs to be done and when it should be 

completed. He then writes a formula to calculate 10 per cent of the products’ prices and a 

formula to work out the new prices of the products. He tests his formula and shows it to his 

manager.

continued …
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… continued

1. How did Charles decide what information was needed in the spreadsheet?

2. How did Charles organise his tasks so that he could manage his time effectively?

3. Imagine you are Charles. What columns of information would you place in your spreadsheet to 

produce the results your manager wants?

4. Write a short paragraph explaining why using a checklist can help you produce a spreadsheet on 

time.
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Information is a valuable asset in any organisation.  
How information is stored and the security measures 
used to protect it are central to an organisation’s 
procedures.

7e spreadsheets you create will usually be stored on 
a server that allows access by multiple users. A server 
is a computer that delivers information and so*ware 
to other computers linked by a network.

To enable staD to log onto a server, the systems 
administrator issues each user with a username. 7e 
user must then create a password. Usernames and 
passwords:

• give users access to the information they require 
to complete workplace tasks

• allow users to have diDerent levels of access to information.

You may ,nd that some of the spreadsheets you work with are con,dential. Ask your 
manager for your organisation’s policies regarding con,dential material.

Document loss
Data also needs to be safeguarded against accidental or deliberate damage. Data loss is 
usually caused by human error or system failure. Many organisations use a data cartridge 
at the end of the day to back up the information on the database. 7is cartridge can then 
be taken oD-site for safety. If any damage occurs to the server or the premises, a complete 
information backup is available.

A server is made up of lots of ,les and folders. Organising this information helps users ,nd 
what they want. If you are saving information onto a server, make sure you know where to 
put it. Find out your organisation’s policies regarding the storage and security of Excel ,les. 

Create a spreadsheet to be used by previous versions 
of Excel
Microso* Excel 2013 has many advanced features that are not available in previous versions. 
If you are creating a spreadsheet that is to be accessed electronically by people with older 
versions of Excel, you will need to work in Compatibility Mode, which turns oD some of 
the newer, more advanced features and ensures that those working in older versions (for 
example, 2003) will still have full editing capabilities.

To create a spreadsheet in Compatibility Mode, select the File tab, select Save as and select 
Excel 97–2003 Workbook in the Save As Type list.

In the ,le name box, type a name for your spreadsheet and click Save. It is important that 
this is done when you are starting to create a spreadsheet.

4C Name and store a spreadsheet, 
and exit an application safely
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Name, store and close spreadsheets
When producing spreadsheets, you need to be aware 
of how to name them and where to store them. 
All organisations have policies and procedures for 
naming and storing spreadsheets. Ask your manager 
to explain your organisation’s requirements.

Files can be stored in so* or hard copy. 7is means 
that they can be stored electronically in a computer 
or in a paper-based form in a ,ling cabinet.

Hard and soft copy storage

Paper reports can become damaged, yellowed and 
brittle. Also, unless you are very careful about 
storage and use, important reports can be easily torn, 
mis,led or accidentally disposed of. Storing many reports can also be expensive and some 
organisations prefer to store information digitally. Digital storage saves on paper and space.

Another advantage to storing reports digitally is that powerful databases can be used to 
search the stored information. Databases enable you to ,nd speci,c information that would 
be much harder to ,nd by searching through hard copies of reports.

Databases also provide management with powerful metrics and reporting tools. For 
example, statistical information can be gathered from a database and detailed reports 
produced.

Folder structure and naming standards

Folder structure and naming standards are needed to allow staD to set up folders quickly 
and easily. Shared directories are folders on a network that a group of people have access to. 

If you use shared directories, you need to assess whether an electronic ,le should be placed 
in the shared directory or stay on your own computer’s hard drive. Decide which reports are 
for your use and which need to be shared.

Advantages of using shared directories and naming standards

 • It can prevent the loss or mis�ling of electronic documents.

 • Work is less likely to be duplicated.

 • It makes it easier to share information between colleagues.

 • Reports on the same or related subjects are located together, which helps 

people �nd and retrieve �les.
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Example: shared directory

To set up a shared directory, you must �rst allocate a shared network drive. Your IT coordinator can 

help with this.

The �rst place to organise a directory is at the folder level. Folders have a tree-like structure that 

branches from a parent directory to sub-folders in a hierarchical structure.

The following example shows the structure of a shared directory.

In this structure, the server has three folders for three separate work groups: Group A, Group B and 

Group C. Group C has three major folders: Procedures, Personnel and Projects. The Projects folder 

includes: Project A, Project B and Project C. Project C has two spreadsheets: ProjectC_time lines.xlsx 

and ProjectC_research1.xlsx. 

The �le path for retrieving a �le starts at the server and ends when the correct �le is located. For 

example, to reach ProjectC_time lines.xlsx, the �le path to follow is  

C:\Group C\Projects\Project C\ProjectC_time lines.xlsx.

In Microsoft Excel 2013, the spreadsheet extension is .xlsx.



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

103

Topic 4
Finalise spreadsheets

Document properties

As well as using user-friendly naming 
and saving conventions and adhering 
to organisational requirements, it can 
be useful to use document properties 
to record common information 
about a ,le.

Document properties assist in 
describing or identifying a ,le and 
include details such as title, author 
name, subject and keywords that state 
the spreadsheet’s topic or content. 7e 
information contained in document 
properties can also be used when 
conducting a search for ,les on your 
computer.

To set document properties, select the 
File tab and select Info.

Back up =les

Many organisations have set procedures for backing up ,les. In many large organisations, 
this is administered through the IT department and is an automatic process. In this case, 
the only thing you need to make sure you have done is to save your ,les to the appropriate 
network drives and folders.

In smaller organisations, it may be necessary for you to back up ,les yourself – this may be 
done on a daily or weekly basis. It may require you to back up ,les to another disk drive. If 
this is the case, check with your supervisor for procedures for backing up.

Backing up ,les is an important protocol. It helps prevent the loss of documents and 
information, and is extremely useful when something happens to the network or 
computer system.

Most folders and ,les are stored on servers and are backed up using external disk drives or 
data cartridges. Information from an entire server can be saved onto an external drive and 
stored in a safe location.

7e organisation should regularly delete old electronic ,les and folders to ensure an eCcient 
use of server space. Always ask for authorisation before making any deletions.

USB memory sticks are also useful for storing and backing up information, especially when 
you require a portable copy of the information.

Hard-copy storage

It is common for spreadsheets that are stored digitally to also be stored in hard copy. 7is 
safeguards against a computer system failure. Hard-copy storage requires space and a ,ling 
system that uses consistent, simple and meaningful names similar to digital storage.
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Hard-copy spreadsheets must be kept up to date. It is necessary to manage hard-copy 
spreadsheets, as storage space in organisations is o*en scarce and valuable. Old or 
superseded spreadsheets must be destroyed on a regular basis. Retention schedules list the 
time frame spreadsheets need to be kept for before they can be destroyed. Spreadsheets 
without permanent value may be scheduled for eventual destruction.

Find out what kind of hard-copy ,ling system is used in your workplace or place of study.

Close applications

A*er creating or modifying an electronic spreadsheet, you need to exit the so*ware 
application without causing damage or loss to the data. Data loss occurs when a computer 
program stops performing its expected function. O*en the program or even the whole 
computer may appear to freeze.

All computer users will experience data loss at 
some time and will be unable to access their data, 
which can be accidentally erased or corrupted and 
made inaccessible. 7e main cause of data loss is 
human error.

7ere are precautions you can take to prevent data 
loss. Try to work on only one spreadsheet at a time.

Data loss can also occur if someone else tampers with 
your work. If you are working on a spreadsheet at 
your workstation, you need to lock your computer or 
exit the application before leaving your workstation 
unattended.

Use multiple applications

If you need to work with multiple applications open, make sure you close applications that 
are no longer needed. 7is will help your computer work more quickly and will prevent data 
loss in the event of computer failure.

Other causes of data loss include virus damage, operating system or application so*ware 
bugs, and failed upgrades.

Another precaution against data loss is to be on your guard with your computer. For 
example, if your computer starts to make unusual noises, shut it down immediately and do 
not turn it back on until you have received advice from an IT coordinator.

To exit the program, select the exit button , which is located in the top right corner of 
the window. If you have recently made changes to your spreadsheet, you will be prompted to 
save these changes.
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Practice task 13

Read the case studies, then answer the questions that follow.

Case studies

Matthew works as an of�ce administrator in a large organisation. His duties include formatting 

reports and saving them on the server. He is also responsible for backing up the server at the 

end of each day. At the end of a busy day, Matthew had completed several reports for different 

departments within the organisation. He had to save each of them in a different location, 

and it took him a while to work out where they all belonged. He wasn’t sure if he had saved 

them all in the correct place. After this, he was running late and decided not to back up the 

server. The next morning, the reports that Matthew had saved were needed for an important 

board meeting. However, during the night a virus had infected the server, destroying all the 

information from the previous day.

Fred has retired from an organisation after working as an administrative assistant for 10 years. 

The areas Fred was responsible for were accounts and projects. The day after he retired, 

someone needed a �le that Fred had created and stored. The �le contained vital accounting 

information. It was discovered that Fred had saved more than 500 �les in a variety of folders 

and the �le could not be located. The folders had ambiguous names such as Folder1 and 

Folder2 and the �les had names such as august1.doc and march2.doc.

1. What would be the consequences if Matthew did not save some of the reports in the correct 

place?

2. Can you think of any consequences of not backing up data on the server?

3. Describe why Fred’s folder and �le naming system failed.

continued …
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… continued

4. Fred was responsible for two areas. What could he have done to make sure �les could be easily 

located?

5. Explain why folder and �le names should be consistent, simple and meaningful.

Summary

1. Producing a spreadsheet means creating it and having it ready for viewing by your 
colleagues or manager.

2. Working within a designated time line means you must plan your work.

3. Make sure you have formatted, checked all formulas and functions, and proofread your 
spreadsheet before printing it.

4. It is possible to print a whole spreadsheet or parts of a spreadsheet, depending on what is 
required.

5. A chart can be printed on its own or as part of a worksheet.

6. You need to understand your organisation’s policies and procedures about saving and 
storing spreadsheets.
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7is learning checkpoint allows you to review your skills and knowledge in ,nalising 
spreadsheets.

Part A
Read the case study, then complete the tasks that follow. Use shortcut keys and menus to 
assist in maximising the eCciency of the so*ware.

Case study

Mario works as a personal assistant for a manager in a large organisation. His manager 

asks him to produce a spreadsheet of customer information. The spreadsheet must list 200 

customers and their accounts. It must also calculate a 10 per cent interest charge on the 

accounts and display customers’ new balances. The spreadsheet needs to be ready in two 

days. The following table lists �ve customers that Mario has to enter:

Customer information

Customers Balances

Sanchez $2,300.00

McGregor $4,000.00

Cunningham $5,000.00

Wijerwadene $4,500.00

Taylor $2,500.00

1. Prepare a checklist of all the tasks Mario will need to do to make sure the worksheet is 
completed on time. 

Learning checkpoint 4 
Finalise spreadsheets
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2. Produce a worksheet with these details, then complete the following tasks: 

• Calculate the 10 per cent interest charge and the customers’ new balances.Check the 
data you entered against the customer information you have been given and correct 
any errors.

• Create a 3-D column chart as an object in the worksheet that displays the 
information visually.

• Name and store your worksheet in a suitable location.

• Select and print the data in your worksheet. Preview the data before printing and 
make adjustments as necessary to format the data.

• Print the chart out as a separate page. Preview the chart before printing and make 
adjustments to include a chart title.

• Exit Excel.

Part B
In this activity you will create a worksheet, accurately enter data, proofread the worksheet, 
write formulas and check that they are correct. Find some data from your workplace, 
previous employment or life experience that needs to be entered in a worksheet. Make sure 
the worksheet requires a formula. Talk to your trainer or supervisor if you need to. Once 
you have identi,ed the data, try to complete the task in one hour. Follow these guidelines 
when entering your data:

• Enter the data accurately and proofread your entries.

• Use formulas and functions to perform at least one calculation. Use a calculator to check 
that your calculation is accurate.

• Ask advice from your manager to ,nd out what you should name your worksheet and 
where you should store it. 

• Print out your worksheet and present it to your manager or trainer.

Part C
In this activity you will create a worksheet, accurately enter data, proofread the worksheet, 
write formulas and check that they are correct. Try to complete this task in one hour.

• Look at the following ‘Sales results’ table. In a worksheet, enter the data exactly as it is in 
the example.

• Calculate the monthly totals and enter them into the ‘Totals’ boxes.

• Use a function to work out the ‘Overall total’.

• Check that all data and calculations you entered are correct. Remember to proofread the 
spelling of the names.

• Name the worksheet ‘Sales results’ and store it in an appropriate place.

• Print out your worksheet to present it to your trainer.
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